


Outertech Linkman

Linkman is a bookmark management solution which supports 10 different
browsers and integrates with Firefox, Internet Explorer and Maxthon.

Linkman calls upon many powerful features that replace the browser's
native URL management and allow to browse faster and more efficiently.

To give you a better impression a Linkman tutorial video can be watched
at http://linkmanvideo.outertech.com

You can choose between two editions.

Linkman Lite (Freeware)

http://linkmanlite.outertech.com

Linkman Lite is free for private non-commercial use as well as for use in
charity organizations and educational use. Private use is only when used
by individuals at home on their private PC. Educational use is by students
for education in school or university.

Linkman Pro ($25 | EUR19 for single computer license)

http://linkmanpro.outertech.com

This edition is intended for the professional user.

Linkman Pro contains all features of Linkman Lite.

In addition these abilities are included:

* Synchronize links between two (or more) computers
* Ability to check URLs for dead links, intelligent (only major) content
changes, and page movements
* Add all links on a single webpage
* Improved keyword features (e.g. Keyword List)
* Replace feature
* Improved Database backup
* Retrieve URL meta tags
* Editable Export Templates (XML, TSV...) with UTF8 support
* Optional installation on USB sticks for mobile usage
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1 Introduction

1.1 Overview

Linkman tutorial on Youtube:

http://www.youtube.com/watch?v=K9k-wVDwYtw&feature=youtu.be&hd=1

Compatibility with all major Windows browsers: 

Firefox, Internet Explorer, Google Chrome, Opera Classic, Opera Webkit, Safari, Chromium, Maxthon
Cloud Browser, SeaMonkey, Avant Ultimate, K-Meleon, Neoplanet, Netcaptor, SlimBrowser

Windows 2000, 2003, XP, Vista, 7, and Windows 8.1, 32 & 64bit.

Supports keywords, ratings, comments, descriptions, shortnames, user defined data, and web icons
Shortcuts to local files can be created in Explorer (right click | Send to -> Linkman), or by drag &
dropping to the Linkman window
Use the same link collection across different browsers (automated synchronization between Firefox, IE
and other browsers)
Synchronization support to share links between multiple computers [Linkman Pro only]
Ability to handle large databases (even millions of links) without performance or stability issues
Optional installation on removable drives like USB sticks [Linkman Pro only]
optional Desktop Toolbar for fastest browsing ever
Internet Explorer integration
Firefox integration
Google Chrome integration
Opera integration
Highly customizable user interface
Detects duplicate links, even if they differ in subdomains, ports or login data
Search for Bookmarks on the same domain or subdomain and display results in groups
User defined rating system
Password generator
Extensive help file including Tutorial
Ability to check Bookmarks for dead links, intelligent (only major) content changes, and page
movements [Linkman Pro only]
Retrieves keywords, descriptions and retrieve custom metatags from web pages
Proxy support with authentication, permanent (LAN) or Dial-Up Internet connections
Direct Internet Explorer Favorites support (including correct item order)
Multiple import & export formats

Firefox Bookmarks
Powermarks
SeaMonkey
Opera Hotlist
Html
Separated Value files
Link search in any data file
Editable Export Templates (XML, TSV...) with UTF8 support [Linkman Pro only]

Fully customizable Html Link webpage generation
Search and Replace
Text and Status type search
Link Collector
Printing support
Password protection
Sort feature with multiple sort orders and autosort
Drop Basket for faster browsing and Bookmark addition
Bookmark Path associated launch
Bookmark Launch History
Fast Links for fast access to your favorite Bookmarks
Daily Links feature for regularly visited sites
Full Drag and Drop support including link drops from browser to Linkman
Advanced Tray Icon (configurable actions)
User defined browser support

http://www.youtube.com/watch?v=K9k-wVDwYtw&feature=youtu.be&hd=1
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Auto save
System-wide hotkeys for easy use, even when working with another application
Advanced localization: User Interface translated to 10 languages
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1.2 What's new

Program History

8.97

* New browser launch method: Topmost browser

This function can be useful for users with multiple portable browsers (Tools | Settings | Launch
bookmarks).

* Multiple bookmarks launch warning is now configurable

When you try to launch more than 15 (default value) bookmarks at once, or a folder with more than 15
bookmarks inside, Linkman will ask you if you really want to do it. (configurable in Tools | Settings |
Launch bookmarks).

* New global hotkey: Show Tray Icon menu at mouse pointer position

* SeaMonkey V2 import

* Improved default browser detection

8.96

* Support for Firefox 38+, Opera 29+, Chrome 43+, IE 11+

* Search columns can now be configured in menu (View | Left-Right Side | Search columns; Search
results right click menu)

* New search method: Selected items content

With this option, search will be performed only in the folders and bookmarks that are selected in the
treeview pane. This option replaces the "selected folder content" option.

* Improved shortcut handling for keywords (Ctrl + Space in Treeview to add new keyword from
keyword list, Ctrl + Enter to select a keyword to search for)

* Consolidated import options

* Browser paths in settings and links to local files in the database support now environment variables

* Improved keyword search typing in keyword list window for handicapped users

* All reported bugs have been fixes

8.95

* Now you can create a diary with Linkman (Tools | Create diary). The structure of the diary (years,
months, weeks, days) can be configured. Diary is available only in Linkman Pro.

* When adding multiple bookmarks at once from a browser the parent folder properties will be displayed
so the name of the folder can be edited (configurable in Tools | Settings | Receive Bookmarks)

* Added "Show in Treeview" button to the Bookmark/Folder properties dialog. It can be useful if the
main window is hidden.

* Restructured the view menu with separation between left and right sides, so it's more intuitive to new
users

* Escape key will hide Linkman to tray if pressed in the main window

* New function in Edit | New to create child folder as the first item of the parent folder (Hotkey Shift +
Ctrl + .)
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* Support for Firefox 34+, Opera 26+, Chrome 40+, IE 11+

8.93

* Support for Firefox 29+, Opera 22+, Chrome 36+

* Keyword List search: multiselect is now possible (search for more than one keyword)

* Clear launch history function

* Bookmark addition tray icon notification: option to turn off in settings

* Multi bookmark addition: folder name is now a combination of first bookmark and current date

* Added more options to Settings | Drop Basket

* Faster database load on Windows 7 and 8|8.1

Bug fixes:

* Firefox 27+ German Umlaut did not import correctly

* Chrome 33+: folder names with the length of 1-2 chars were not imported correctly

* main window maximize did not stick if the start hidden option was active

8.92

* Linkman displays now a notification when a new bookmark is added from browser

* Fixed existing bookmark detection (was not working in some uncommon cases)

* Improved UI responsiveness during bookmark validation on slower computers

8.91

* Support for Firefox 26, Opera 19, Chrome 32

* Path sort will now also sort Folders by name

* Improved compatibility with Windows 8.1. The Linkman IE Toolbar can now also be used with IE 11 on
Windows 8.1, but you must disable the enhanced protected mode first:

1. click the settings icon in the right top corner of IE 11 to display the menu
2. select Inte rne t Options
3. go to Advanced tab
4. scroll down to Security section
5. Make sure Enable  enhanced pro tected m ode* is NOT checked
6. Restart IE, the Linkman toolbar will be available again 

Bug fixes:

* adding a large numbers of bookmarks from the Opera addon at the same time

* send to Linkman Explorer function will now accept folders

* fixed URL launch with latest Seamonkey

* improved compatibility with Thunderbird

* fixed handling of some user defined browsers

8.90

* Support for Firefox 24 and Chrome 30+
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* Configurable right-click menus

* Significantly faster communication between Linkman and web browsers

* Improved Safari detection

* Firefox import: added support for separators

* Keyword list window: keyword is now added to all selected bookmarks

* Better handling of screen densities above 96 DPI

* Bug fixes

8.85

* New Linkman tutorial video (Bookmark to Youtube will be placed on Desktop after installation)

Direct link: http://www.youtube.com/watch?v=K9k-wVDwYtw&feature=youtu.be&hd=1

* Added Path to Sort methods

* "Add Bookmark from browser" hotkey looks now also for URLs/Links in Clipboard, so Bookmarks from
unsupported browsers can be added

* Added Modification Date search to Link Collector

* All reported bugs fixed

New or improved web browser support:

* Initial Safari support

* Initial Opera Webkit (15+) support (including Addon)

* Google Chrome 29+ support

* Firefox 23+ support

* Initial Avant Ultimate Support

* Initial Maxthon Cloud Browser Support

8.8.0.40

* Keyword list will display now also keywords with only 2 letters (old limit was 3 letters)

* Stay on Top option of Desktop Toolbar is available again

* Improved description retrieval for Add and Edit bookmark function

* Internal Bookmark Validation improvements

* Local files from Explorer can be drag & dropped now also to the search window and Desktop Toolbar
(worked before only with the main window and Drop Basket)

* Fixed a time zone bug in Link Collector add/visit date search

8.8.0.26

* Properties dialog: when the user is editing keywords while a keyword update/retrieval process is
completed in the background, the web keywords and the user input will be merged using a comma now

* After successful synchronization Linkman Pro tray icon hint will display the filename and date
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* Added copy to clipboard button to options tab | old path of bookmark properties dialog

* Fixed several issues with the Opera browser

* Keyword list will display now also keywords with only 3 letters (old limit was 4 letters)

* If the Linkman web icons data-file (.licons) is damaged, Linkman will create a new one now; the web
icons can be recreated by doing a complete bookmark validation in the tools menu

* When the user changes the web path of a bookmark, the validation status icon is reset

* Bookmark validation resume was not always working when a server send bad URL data

* Implemented bookmark validation work-around for bookmarks with incorrectly set path anchors

* Hotkey changes:

main window:
changed swap databases hotkey from ctrl + u to ctrl + j
changed expand treeview from ctrl + j to ctrl + +key
added ctrl + enter to show keyword list window (pro only)

search edit (main window and search window):
added ctrl + space to show keyword list window (pro only)

properties window keyword field:
added ctrl + enter to show keyword list window (pro only)
added ctrl + space to show keyword list window (pro only)

8.8.0.16

Functionality Changes:

* The Linkman tray icon will change its color to indicate a status change:

Red Icon: normal (default) operation mode

Purple Icon: Linkman is loading or saving a bookmark database file

Green Icon: Linkman has just synchronized a bookmark file using an external synchronization service
like Dropbox or Google Drive. The Icon will stay green until a new bookmark is added, or an existing
deleted.

* The last bookmark/folder selection is now stored in the lmd database instead of registry/ini file

* Added Firefox 22 and Google Chrome 26 compatibility

* When adding bookmark paths (for example http://www.outertech.com) from Clipboard Linkman will
retrieve the bookmark name

* Improved Powermarks import

* Added "Start Linkman with Windows" option to Linkman Pro installer

* Separated installer Start Menu and Desktop shortcuts into two sections

Bug fixes:

* Layout problems on low resolution monitors

* Internet Explorer 9 detection on some systems

* Fixed a potential crash if an addon is blocking the Firefox communication queue
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* Implemented a bookmark validation work around for Jetty web servers

* Autosave after receiving bookmark option works now also with adding via drag & drop

* Work around for OLE error dialogs on systems with OLE registry errors

* Some other minor fixes

8.80

* Improved Bookmark Validation (Linkman Pro only):

- Authentication support: if user and password are set in the bookmark properties Linkman
will log-in to the website during Bookmark Validation in order to check the status; if
no username and password is specified a new "key" symbol will be displayed after validation
- Improved SSL/TLS support: Linkman can now connect to all https:// servers 
- Linkman can now successfully check servers that do not adhere to the HTTP 1.0/1.1 specifications
- Added text explanation of validation status codes to the status bar
- Faster validation on databases with many bad (non existing) web site paths

* Better Web Icons support (Linkman Pro only):

- PNG, JPG and GIF images are now also supported
- if the web icon of a website is placed on another website with
a shortcut referral to it Linkman will find the icon anyway

* Improved synchronization (Linkman Pro only):

- A warning dialog will be displayed on synchronization collision (when the database has
been synchronized externally, for example by Dropbox, while you were making changes
to the local database)
- On successful synchronization a notification is displayed in the Tray Icon area

* Major internal changes to the optional Internet Explorer Linkman toolbar:

- protocol changed from Named Pipes to TCP/IP resulting in better stability with large databases
- improved Internet Explorer 10 support
- improved Windows 8 support
- Linkman search window can now be optionally shown by using one of the toolbar buttons

* Faster and more accessible Keyword List window (Linkman Pro only)

- Keyword caching optimized for multi-core processors; shows up instantly on large databases
- Keyword button added to the left side of the search edit (both in the main and search window)
to access the Keyword List quickly
- Ctrl + Enter shortcut added to the search edit to show the keyword list

* Specific browser can be now also configured in the properties of a folder.
All bookmarks inside this folder will be launched using the configured browser.

* Settings | Program Exit has now a privacy section, where you
can configure if launch and search history should be saved

* Improved handling of the case where the user tries to load the same
database to the left and the right panel at the same time

* Added URL.USER and URL.PASSWORD tags to export templates

* Search function will display completion time also on non successful searches

* Phrase search (using quotations) was sometimes not working (fixed)

* Improved Chromium support

* Added save date, username, and computername to status section of File | Properties
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(you need to save at least once with 8.80 to see any data here)

* Many small interface improvements

8.71

* Bug Fix Release

8.70

* Support for web icons (Linkman Pro only).

This feature was often requested, but not implemented until now
for performance reasons. Finally we have found a way to implement
it with acceptable performance. The feature can be disabled in
Tools | Settings | Data (recommended for large databases with more
than 20.000 links). The web icon cache is saved into a separate file with
the same base filename as your database, but a different extension (.licons).
Icons are automatically added to new bookmarks. To add icons to your existing
bookmarks, use the 'Bookmark | Update web icons' function.

* Improved support for local files.

Shortcuts to local files can be created more easily. Select the files in
Explorer, right click and use the Send to -> Linkman function.
Alternatively multiple files can be drag & dropped from Explorer
to a Linkman window or the 'Bookmark | Add shortcuts to local files'
menu function can be used.

* Time edit fields have been added to Properties dialog status tab.

* Improved Google Chrome import (creation date is imported now).

* Compatibility update with the latest browsers.

8.50

* General Addon overhaul to support the latest versions of the Chrome, Firefox, Internet Explorer, and
Opera browsers.

* Windows 8 RTM support

8.40

* Firefox 11 support

* Faster URL launching in Firefox 6-11

* New search options:

Besides #n (for example #3) to find bookmarks/folders with a specific rating, you can now use also >n
 (for example >1) and <n (for example <3) to find bookmarks/folders that have a greater or lesser
rating; this can be combined in and/or searches. For example a search for ne ws >3 will show all
bookmarks/folders with the keywords ne ws and a rating grea te r than 3.

* Search and Properties dialogs can be configured to display at mouse cursor:

Button in Properties dialog.
Menu option in Search dialog.

* Improved privacy settings: saving of search and launch history can be disabled in the Search dialog
launch menu.

* Added more shortcuts (see Hotkeys and Shortcuts section of the tutorial)
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* Fixed drag & drop issues with some left-handed oem mouses

* When adding new bookmarks, Linkman will not overwrite user entered descriptions anymore

* Improved support for systems with more than two monitors

8.32

* Firefox 9 and 10 compatibility

* Work-around for IE 9.0.4 drag & drop and query problems

8.31

* Added folder history to Bookmark properties dialog

* Improved Firefox 8 compatibility

* Fixed problems with IE9 integration

8.30

* Firefox 7 and 8 (Beta) compatibility including Firefox 7 and 8 Addon (works also with 3-6)

* Initial Windows 8 support

* Browser command line parameters can be set in Settings | Browser

* After unhiding from tray area Linkman will restore the cursor to the last focused position

8.20

* Firefox 6 compatibility including Firefox 6 Addon (works also with 3-5)

* Added password generator to Bookmark properties dialog

* Added a button to search dialog to quickly switch the Stay On Top status

8.10

* Firefox 5 compatibility including Firefox 5 Addon (works also with 3.6 and 4.0)

* Chrome 13 compatibility including Google Chrome 13 Addon (works also with 10-12)

* You can limit search to specific bookmark ratings using #rating, e.g. a search for manager #3 will
display
   all bookmarks that contain the keyword manager and have a rating of 3

* Search & replace can be performed also on selected items only

* Linkman will display a confirmation dialog if you try to launch more than 30 links at once

* Several user interface tweaks and 2 bug fixes

8.0

* Firefox 4 Addon (works also with 3.6)

* Improved Internet Explorer Addon: works with UAC enabled, added compatibility for Internet Explorer
9

* Google Chrome Addon (all versions)

* Opera 11 Addon
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* Bookmark properties dialog can be resized

* The initial focus of Bookmark properties dialog can be configured (Options Tab) 

* Alternate combobox display for numeric user defined data fields

* Query Favorites can be created in search window (Linkman Pro)

* In searches AND NOT can be substituted with a - sign
  for example:
  a search for: foo -bar
  is the same as: foo and not bar

* Replace dialog: use * to delete fields (Linkman Pro)
  for example:
  enter * as new text, do not enter anything as new text
  Enable Keywords Checkbox
  Click Replace All and all Keywords content will be deleted

* Added Time to Date display in search results

* Added "Page changed" Date/Time column to Search results

* Rearranged some Hotkeys due to user suggestions (see Hotkey list for details)

* Improved search experience on very large databases (100.000 links and more)

* Many tweaks and some bug fixes

7.90

* Firefox has now optional Linkman buttons in the main toolbar. Rightclick the Firefox toolbar and select
customize.

* Firefox can now be configured to launch links into existing tabs. Tools | Settings | Launch Bookmarks.

* Chrome 4.x-5.x support (including import)

* Toolbar buttons available in two different sizes

* Improved support for sharing Linkman links between two computers.
 
Linkman Pro will detect if Dropbox or Syncplicity (or any other such sync service) changes the Bookmark
Database (*.lmd) while Linkman is running. If the user has not any pending changes to save, Linkman
will reload its database.

See the Synchronize tutorial for a screenshot based guide.

Example:

You are at your work computer and add some links to Linkman. You go home and turn on your
computer. Linkman will load, but the database will not have the links you have added at work at this
moment. Dropbox will download (without any need of user interaction) the database changed at work.
After Dropbox is done, Linkman will automatically reload the database and the new added links will
become instantly available in your browser. This works of course also if you add links to your home
computer. They will become available on your work computer.

The feature can be turned off in Tools | Settings | Data.

* Keyword List window (Linkman Pro only)

The Keywords labels in the main window and the Bookmark add window have been replaced by
Keywords buttons. Clicking on one of these button will display a list of all keywords in your current
database. When you start typing a keyword Linkman will search for it in the list. Clicking Add or pressing
the Enter key will add this keyword to the current Bookmark.
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* Add Keywords to selected items (Edit, Shortcut and Query menu, Linkman Pro only)

This function can add a specific keyword(s) to all selected Bookmarks and folders.

* Add all Bookmarks on this webpage (Bookmark, Shortcut and Query menu, Linkman Pro only)

Linkman will load the html page from the Bookmark, parse it for links and add all links to a new folder.

* Firefox 3-22+ Import converts tags to Linkman keywords (this was not trivial to implement, as Firefox
stores tags in a weird and inefficient way)

* Firefox integration will now load Linkman on demand (if not already loaded)

* Added Modified and Page changed (Dates) columns to Query areas in main window, search window
and Desktop Toolbar

* You can add tabulators to comment text by pressing shift + tab

* Several bug fixes, speed and user interface improvements (Linkman Lite and Linkman Pro)

7.81

Extended Database History Feature (Tools | Settings | Data | Backup old Linkman Data files). By default
Linkman will keep 2 + 1 (two older and one current version) Database files. The history can be
configured to save up to 10 older databases.

Added <parent.userdef1> to <parent.userdef6> tags to export templates.

Additionally this update fixes several bugs.

7.80

Added more Buttons to Firefox integration
Improved Printing: QueryPrint, Userdef fields, configurable margins
Query option to search for whole words only (default off)
Query option to autocomplete search terms (default off)
Added date support to Powermarks import
Increased the size of keywords edit area in Bookmark properties window
When adding Bookmarks you get the option to edit a Bookmark if it already exists
Query results can be exported using Templates (File | Export, Pro version only)
Added <PARENT.KEYWORDS> and <PARENT.COMMENT> Tags to Export Templates (Pro version only)
Ascending/Descending option in Autosort
Query Results font is now configurable (Tools | Settings | Interface)
Added more Bookmark Launch options to context menus
If Linkman is hidden "Add and Edit to Linkman" will restore focus back to browser
New option to add browser links to the top of the database (Tools | Settings | Receive Bookmarks)
Tools | Settings | Interface | Show Treeview lines turns also Query Results lines on/off
Bug Fixes

7.71

Improved Powermarks import
Added Shortnames to Separated Value File import
Internet Explorer Toolbar allows to disable Linkman entries in IE's context menu
Improved launching of multiple Bookmarks at once
Fixed a graphical glitch when batch assigning ratings
When changing font size (Tools | Settings | Interface | GUI Font) the text size of comments and
descriptions will also change
Many other smaller tweaks and fixes

7.70

Firefox 3.1 compatibility and integration enhancements
Added feature to Internet Explorer to add all Tabs at once to Linkman
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Over 20 new mouse and keyboard Shortcuts
Improved USB Stick installation: Linkman will find his link databases even if you move them between
different USB Sticks and Computers
User Interface tweaks and speedups
More Screenshots added to CHM and PDF tutorials
Query search improvements: and search is now active by default (instead of phrase search)

Example:

Before you had to type: hardware and news and not 3d
Now it's enough to type: hardware news not 3d

if you want to search for the phrase hardware news type "hardware news" instead

7.60

Firefox 3 integration
Improved Internet Explorer integration
Several minor tweaks and improvements
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7.51

Bookmark Validation can retrieve missing Bookmark names
Links can be added to Linkman using Internet Explorer Right-Click menu

7.50

Google Chrome support
Internet Explorer 8 Beta 2 support
K-Meleon support
Maxthon support
Firefox 3 Bookmarks Import
Powermarks Import
User Interface Improvements (for example Bookmark ratings can be changed for multiple Bookmarks at
once)
Separated automatic retrieval of Bookmark Keywords and Description (Tools | Settings | Receive

Bookmarks)
Query History
Query "and search" improvements:

When searching for multiple terms, name and keywords of the parent folder will be taken into
consideration for every link inside.

Example:

You have a folder called music with several links inside. Some of these links have the keyword software.
If you search for music software all of these links will be found, even if they don't possess the music
keyword.

7.30

Internet Explorer 8 and Firefox 3 support
Installer option to install Linkman on a removable drive (e.g. USB stick)
Firefox import/export preserves RSS feed and Icon information
Bookmark Validation can retrieve custom metatags
Resizable Bookmark Edit area in the main window
File locations of Export Templates, Daily and Fast Links can be changed in the GUI
Move to dialog (Main menu, Shortcut menu, Bookmark properties dialog)
Several smaller improvements and bug fixes

7.20

Fuzzy Duplicate search, both as status query and link by link display
Status Query can display Bookmarks belonging to a specific Subdomain or Domain in groups
Content of selected folder can be displayed as a Query on click
Optional alternate Bookmark Validation Icons for colorblind users (Settings | Interface)
Mozilla SeaMonkey support
Improved Bookmark detection for Internet Explorer windows with modified title
Several user interface and performance improvements
New global hotkey to quickly show/hide the Desktop Toolbar  (Settings | Global Hotkeys)
Bug fixes

7.10

Search and Replace (Edit menu)
Almost instant queries on very large databases (100.000+ links)
Optimizations for Dual and Quad Core processors
All types of local files and folders can be added to and launched from Linkman Databases
Option to make Query background colors brighter (Treeview | Properties)
Several minor bugs fixed
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7.01

Added a feature to change folders directly within the properties dialog
IE Toolbar version 1.1: fixed compatibility, added new options
New global hotkeys: Search for text in clipboard, Query for text in clipboard, Activate Desktop Toolbar
New setting: Collapse folders after load (Settings | Data)
Added description & userdef edit fields to main window
Fixed compatibility problems with comodo firewall
Several bugs fixed (see changelog.txt for complete list)

7.0

Desktop Toolbar
Windows Vista support
Internet Explorer 7 support (Settings | Browser)
Firefox 2 support (Settings | Browser)
Launch new links into tabs or new windows (Settings | Launch Bookmarks)
Launch complete folders contents in Browser tabs (Settings | Launch Bookmarks)
Open Daily Links into tabs or new windows (Daily Links Menu | Settings)
Drag & Drop improvements
Automatically updates moved web pages during Bookmark Validation
Significantly faster Bookmark Validation
Numerous smaller functionality improvements
Several bug fixes
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1.3 Other software

Cacheman is a Windows software designed to speed up your computer by optimizing several caches,
managing RAM and fine tuning system settings. Auto-Optimization makes it suitable for novice and
intermediate users yet it is also powerful and versatile enough for computer experts. Backups of settings
ensure that all user modifications can be reversed with a single click. Cacheman runs on Windows XP,
Vista,7 x86/x64.

When typing text many users feel an urge for an improved Clipboard. A single storage for text is simply
not enough. The freeware Clipboard History application gives you the power to paste up to twenty last
Clipboard text entries into any application. Just press the usually unused Capslock key and a paste menu
will be shown.

StartEd Pro is a tool which helps you to manage Programs which load from the Registry, Startup folders
and as System Services at Windows Startup. It lets you modify and backup the Startup configuration and
detects more than 150 Trojan Horses. StartEd displays detailed info about the functionality of every
System Service. A freeware edition of StartEd (for private and educational usage) is also available as a
separate download.

StartEd Lite is a freeware version of StartEd without the backup feature.

GetDiz is a fully featured text editor which can replace Notepad while maintaining an incredible speed,
ease of use and small size. You can display and edit any text files with GetDiz. Additionally it offers
enhanced functionality with DIZ and NFO files, which are often included in ZIP archives. GetDiz is able to
display ASCII art correctly and save text, nfo and diz files as GIF images. The user interface is handy,
small and specific. An optional USB-Stick installation is also possible.

With Batchrun you can create batch files using a graphical interface. In the good old days of DOS, batch
files (.bat) took care of this task. They still do, but they're not exactly user friendly. Batchrun launches
any number of programs simultaneously, with just a simple click. You can control the starting process
with many properties like priority or run mode and control their behavior a tad. You can even do more
than starting programs with the built-in file management functions like Copy, Rename, Makedir, Delete
and End Process. Batchrun batch files can be launched from Explorer or placed in StartUp folder or on
the Desktop.

Download all at http://www.outertech.com.
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2 Frequently Asked Questions

How to add web icons to existing bookmarks?

Icons are automatically added to new bookmarks. To add icons to your existing
bookmarks, use the 'Bookmark | Update web icons' function.
Web icons are only available in the Pro edition of Linkman.

How to create shortcuts to local files in Linkman?

Select the files in Explorer, right click and use the Send to -> Linkman function.
Alternatively multiple files can be drag & dropped from Explorer to a Linkman window
or the 'Bookmark | Add shortcuts to local files' menu function can be used.

How to handle the browser communication could not be activated at TCP/IP Port 80 error?

Linkman communicates with the browsers using the TCP/IP protocol, so you can add or search Linkman
links
directly in your browser. By default the "port" (connection channel) number 80 is used for this purpose.
This works on 99% of all computers. On some computers another software may use the port number 80
already, so you get the activation error. To establish communication between your Browser and Linkman
you have to choose another port.

Step 1: In Linkman go to Tools | Settings | Browser and change the port from 80 to 81.
Step 2: In your browser go to the Addon Manager and look for the Linkman Addon.

In options | settings of the Linkman Addon change the port from 80 to 81.

How to reinstall the Linkman Firefox/Chrome/Opera Addons? 

Visit http://www.outertech.com with the Browser you need the addon to be reinstalled. Scroll down until
you see the Linkman menu on the left side.

Click on the corresponding addon and follow the instructions.

How to customize the search column display?

Search columns can be configured in menu (View | Left-Right Side | Search columns; Search results
right click menu).

If you want to change the order of the columns drag & drop the column headers.

How to add a secondary sorting method to search results?

First go to Edit | Search and select the primary sorting criteria (e.g. Name). Then click header of the
search column you want
sorted (e.g. launch date) to select a secondary sorting criteria.

Can I use the same database for my home and my work computers without taking it along
on a USB stick?

Please refer to the Synchronization section of the tutorial.

What does the term URL mean?

URL stands for Uniform Resource Locator. In popular usage a URL is referred to as a world wide web
address.

In Linkman's help files the term URL is used to describe a Linkman link, a Firefox bookmark or a IE
Favorite.

How to add a keyword to multiple links at once?

Use the Edit | Add Keywords to selected items function.

http://www.outertech.com
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When searching for multiple terms, name and keywords of the parent folder will be taken into
consideration for every link inside.

Example:

You have a folder called music with several links inside. Some of these links have the keyword software.
If you search for music software all of these links will be found, even if they don't possess the music
keyword.

So if you want to add a keyword to several links at once, simply at the keyword to the folder that
contains these links instead.

This works also with folders, to add a keyword to multiple folders at once, add it to the parent folder that
contains these folders instead.

Note: Linkman Pro (not Linkman Lite) has also a "Add Keyword to the selected links" feature in the
shortcut menu.

Why does the Internet Explorer Toolbar not work on my Windows Vista computer?

You have probably an older version of the Toolbar installed. You need the toolbar that comes with
Linkman 8.

I see a small window with an earth picture on my Desktop! What's the purpose of this
window?

The window is the Linkman Drop Basket - please go to this section for more information.

How do I see if the content of the Bookmark web page has changed?

After the Bookmark validation and Page changed check the names of the Bookmarks with changed
content are underlined.

You can also display all changed webpages by doing a query. Select "page changed" as query type.

How to play Winamp streams with Linkman?

Set Winamp as User Defined browser in Tools | Settings | Browsers.

Set every stream Bookmark (e.g. http://www.shoutcast.com/sbin/shoutcast-playlist.pls?
rn=1192&file=filename.pls) to launch with User Defined browser. (Options section of Bookmark 
Properties).

May I distribute the Trial version of Linkman Pro?

You can distribute Linkman Pro if you agree to our Disclaimer Agreement.

Can I change the order in which Linkman displays Bookmarks in the Drop Basket Left/Right
Treeview menu?

not directly, but you can do it with some manual work:

launch the registry editor (Regedit.exe), go to HKEY_CURRENT_USER\Software\Outer
Technologies\Linkman
search for the Bas_MenuOrder section and modify the data from 1 to 0

Why can't I see all Tree items in the Tray Icon / Drop Basket Treeview menus?

By default Linkman limits every sub-menu to 40 items to speed up menu drawing. Go to Tools | Settings
| Tray Icon to set the maximum number of Bookmarks which should be visible in the Tray and Drop
Basket Tree menu. 

Why does Linkman not store Bookmark launch dates?
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Enable launch dates storage in Tools | Settings | Data.

How to disable Bookmark History?

Go to Tools | Settings | Tray Icon and set max items to 0. Alternatively open the Search window and
disable search/launch history altogether.

Why does Drag & Drop between my Browser and Drop Basket does not work?

Linkman does support drag & drop between applications, but the drag & drop is a 2 way process so the
Browser must also support drag & drop between applications.

Currently these browsers have such support:

Internet Explorer, Google Chrome, Firefox, Maxthon, K-Meleon, Netscape Navigator, Mozilla, SeaMonkey,
Avant Browser, Neoplanet, Netcaptor

These browsers don't have such support: Opera

Why does Bookmark launching to a new tab not work with Mozilla SeaMonkey?

If you want to use tabbed Browsing with Linkman and SeaMonkey please activate it first within
SeaMonkey (Edit | Preferences | Navigator | Tabbed Browsing | Links from other Applications).

How to export to Firefox?

The only way to export Fire fox  Bookmarks from Linkman is to export them in the format of Fire fox  2 (
Bookmarks.html) first and then import manually into Fire fox .

In Linkman go to File | Export | Bookmarks.html.

Within Firefox: Select the Bookmarks main menu in Firefox, then go to Organize Bookmarks... | Import
and Backup | Import Bookmarks from Html and choose the Bookmarks.html file exported with
Linkman.
 

How to export to Google Chrome?

The only way to export Chrome Bookmarks from Linkman is to export them in the format of Internet
Explorer (Favorites) and then import manually into Chrome (Select Bookmarks | Import Bookmarks
and Settings | Microsoft Internet Explorer from the main menu in Google Chrome). 

Why does Linkman change the Tray Icon color from time to time?

The Linkman tray icon can change its color to indicate a status change:

Red Icon normal operation mode
Purple Icon Linkman is loading or saving a bookmark database file
Green Icon Linkman has just synchronized a bookmark file using an external synchronization service
like Dropbox or Google Drive. The Icon will stay green until a new bookmark is added, or an existing
deleted.
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3 Tutorial

3.1 First steps

A good beginning is to watch the tutorial video on .

After this you must make 3 important decisions about your desired Linkman usage.

1. Do you want Linkman to load automatically on Windows startup?

This is the default setting, Linkman will load on Windows startup and hide to the system tray. We highly
recommend to keep this setting.

You can access Linkman thru the Tray Icon and also directly from your browser menus. Alternatively you
can set hotkeys for many Linkman functions. These hotkeys will also work in your browser. With
Firefox, Chrome and Opera you can place Linkman button(s) directly on the main toolbar. With
Internet Explorer you can display a Linkman Toolbar in the View | Toolbars menu.

To show Linkman's main window double-click on the Tray Icon.

You can assign 3 click events (left mouse single click, left mouse double click, right mouse click) directly
to the Tray Icon in Tools | Settings | Tray Icon.

If you don't want Linkman to be available on Windows startup go to Tools | Settings | Program start and
change the configuration.
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2. Do you want to use the Drop Basket?

The Drop Basket is a special Linkman window that is always on top of other applications.

You can activate the Drop Basket in the View menu.

To move the Drop Basket to a different position click on it with the left mouse button and keep the
button pressed while moving the mouse. You can drag & drop Links from Internet Explorer, Firefox,
Mozilla and some other browsers to this window to add them to Linkman (examples in Drag & Drop
section of this tutorial). You can also access some of Linkman functions on the shortcut menu of the Drop
Basket.

To configure the Drop Basket mouse click events and image go to Tools | Settings | Drop Basket.

If you don't want to use the Drop Basket simply turn it off by unchecking Visible (as seen on
screenshot).
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3. Do you want to use the Desktop Toolbar?

The Linkman Desktop Toolbar is one of Linkman's most powerful features. It allows you to store, edit,
search and launch links efficiently.

The Toolbar is still visible after the Linkman main window has been hidden to Tray Icon.

If you don't want to use the Desktop Toolbar, you can disable it in the View menu.

You get more info on the Toolbar in the next Tutorial section.

4. Which file format do you want to use with Linkman?

You can select between the proprietary Linkman Data (lmd) format and Internet Explorer
Favorites. 

You can also import Google Chrome Bookmarks, Firefox 2-8+ Bookmarks, or the Opera Hotlist
on every Linkman start, but you will not be able to use Linkman to the full extend this way (e.g. Ratings
or User defined fields are not saved with Firefox/Opera export, since these browsers do not support such
features). Firefox 3-22+ and Google Chrome do not allow to write to their respective Bookmark
Databases while they are running (this is a technical limitation of the SQLITE database format and will
not be fixed). It's still possible to export Linkman Bookmarks/Folders to these browsers, but it has to be
done manually. Please read the Import and Export tutorial for details.

Advantages of the Linkman Data (lmd) format:

- Only one file for a bookmark collection
- You can divide your bookmarks into separate files (e.g. Business, Private or password protected Adult
Links).
- Lower disk space usage
- Faster load/save process
- optional Password protection
- Easy backup and transport (USB Stick etc)
- Virtually unlimited amount of Bookmarks possible
- Linkman [Pro Edition] can export template files when saving lmd files (Tools | Settings | Data)
- The lmd files format is also editable with any text editor (like notepad) due to the XML-like structure

The lmd data format has been praised for 14 years for it's data security.

a, You decide to use Linkman XML Data files (strongly recommended).

As the first step you must create a new file, alternatively you can use the example data file delivered
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with Linkman. Many Tutorial examples are based on the included database (m ySam pleLinks.lm d).

Creating a new Database file

Linkman will create a new database automatically if you add a new link from your browser when no
database is loaded into Linkman.

Alternatively you can create a new database file manually.

To create a new file select File | Save as..., browse to the desired directory and enter a filename, e.g.
m yData .lm d

Linkman will load this file automatically from now on.

The next step is to add your existing links to the newly created lmd file.

Select the appropriate menu point in the File | Append submenu. The append function ignores all links
that do already exist in the loaded database. This way you can import your data from more than one
browser.
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m yData .lm d with some imported Links:
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Loading the included example Data file

Select File | Open and load the file called m ySam pleLinks.lm d.

If you want to use this data file as your default Bookmark file you should rename it, since the next
Linkman update will include an updated m ySam pleLinks.lm d file and the installer would overwrite your
links! To save the file under a different name select File | Save as... (use e.g. m yFirstData .lm d as
filename).

Linkman with loaded example data file:
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b, You decide to use IE Favorites or Opera Hotlist

Please refer to the Import & Export tutorial to understand why this is not a  feasib le  option with Google
Chrome and Firefox 3-22+). 

You can still load Chrome and Firefox 3-22+ at every startup for synchronization purposes. For example
you can let load your Linkman Data file into the Left Treeview, Chrome/Firefox 3-22+ Bookmarks into
the Right Treeview, Set focus to Right Treeview and Synchronize. All Bookmarks/Folders not present in
your Linkman Bookmark collection will be added to it.

Here you can see the Linkman window switched to two Treeview mode (using the View main menu):

If you want Linkman to load your IE Favorites, Chrome or Firefox Bookmarks on program start you must
change the Startup task list - launch Tools | Settings.

By default Linkman loads the last used lmd files into both Treeviews.
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If you want Linkman to load the IE Favorites on program start change the left Treeview to open IE
Favorites.



36

Tutorial

Linkman

Click the ... button and select your IE Favorites directory.

Click Ok to save the settings.

Opera Hotlist must be loaded manually on startup because the opera import is implemented as a
Linkman plugin. You can set the default Opera Hotlist file in the Import & Export section of the Settings
window.

Notice: If you have decided to go with IE Favorites Linkman will create a security backup when saving
(hidden lmd file in Favorites directory).

Database Tips

Linkman will save the database automatically if you add a new link from your browser to it (in the
browser's menu). To change this behavior go to Tools | Settings | Receive Bookmarks and turn off
Autosave.

Linkman will ask you on exit if you want to save other changes (if any). If you want Linkman always to
save on exit without asking, disable the confirmation dialog in the Program exit section of settings.

You can also set a periodic (e.g. every 10 minutes) Autosave in Tools | Settings | Data.



Tutorial

37Linkman

3.2 Internet Explorer integration

Linkman offers an Internet Explorer 7.0-11.x Addon to allow you a direct interaction with Linkman in the
browser. The addon is installed automatically when you install Linkman.

After installation, the Addon must be configured as shown in the image below.

In the search field you can use wildcards and operators to combine search terms. AND (default), OR,
AND NOT and the '-' sign can be used. Example: a search for network tweak -adsl will find all links
containing the keyword network AND the keyword tweak, but NOT containing the keyword adsl.

Attention Windows 8.1 users!
The  Linkm an IE Too lbar can now a lso  be  used w ith IE 11 on W indows 8.1.1, but you m ust d isable  the
enhanced pro tected m ode  first:
1. c lick  the  se ttings icon in the  r ight top corne r o f Inte rne t Explore r 11 to  d isp lay  the  m enu
2. se lect Inte rne t Options
3. go  to  Advanced tab
4. scro ll down to  Security  section
5. ensure  tha t Enable  enhanced pro tected m ode* is  not checked
6. resta rt IE, the  Linkm an too lbar w ill be  ava ilab le  aga in 
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Linkman functionality is also available in the right click menu.
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3.3 Firefox integration

Linkman offers a Firefox Addon to allow you a direct interaction with Linkman in the browser. The addon
is installed automatically when you install Linkman.

It can also be installed manually. Make sure you are visiting this page (http://www.outertech.com/en/
firefox-bookmark-manager) with Firefox.

After installation, the Addon must be configured as shown in the image below.

In the search window Linkman uses wildcards and operators to combine search terms. AND (DEFAULT),
OR, AND NOT and the '-' sign can be used. Example: a search for backup software -usb will find all links
containing the keyword backup AND the keyword software, but NOT containing the keyword usb.

You can enable the Add-on bar to get Linkman icons in the right corner of the Firefox window.

http://www.outertech.com/en/firefox-bookmark-manager
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Linkman functionality is also available in the right click menu.

Alternatively you can set hotkeys for many Linkman functions. These hotkeys will also work in your
browser.
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Firefox and Linkman communicate over TCP/IP port 80.

If you use this port for another application you can configure Firefox and Linkman to exchange data over
a different port (Addons | Extensions | LinkmanFox | Options).

You know when you need to change the port from 80 to e.g. 81 if Linkman does not respond to the
addon clicks (should not be needed on 99% of all computers).

The communication port must be also changed in Linkman (Tools | Settings | Browser).
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3.4 Google Chrome integration

Linkman offers a Chrome Addon to allow you a direct interaction with Linkman in the browser. The addon
is installed automatically when you install Linkman.

It can also be installed manually. Make sure you are visiting this page (http://www.outertech.com/en/
chrome-bookmark-manager) with Chrome.

In the search window Linkman uses wildcards and operators to combine search terms. AND (DEFAULT),
OR, AND NOT and the '-' sign can be used. Example: a search for backup software -usb will find all links
containing the keyword backup AND the keyword software, but NOT containing the keyword usb.

Chrome and Linkman communicate over TCP/IP port 80.

If you use this port for another application you can configure Chrome and Linkman to exchange data
over a different port (Menu Button | Tools | Extensions | Linkman | Options).

You know when you need to change the port from 80 to e.g. 81 if Linkman does not respond to the
addon clicks (should not be needed on 99% of all computers).

The communication port must be also changed in Linkman (Tools | Settings | Browser).

http://www.outertech.com/en/chrome-bookmark-manager
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3.5 Opera integration

Linkman offers an Opera 11 Addon to allow you a direct interaction with Linkman in the browser. The
addon is installed automatically when you install Linkman.

It can also be installed manually. Make sure you are visiting this page (http://www.outertech.com/en/
opera-bookmark-manager) with Opera.

In the search window Linkman uses wildcards and operators to combine search terms. AND (default),
OR, AND NOT and the '-' sign can be used. Example: a search for cheap computer -apple will find all
links containing the keyword cheap AND the keyword computer, but NOT containing the keyword apple.

Opera and Linkman communicate over TCP/IP port 80.

If you use this port for another application you can configure Opera and Linkman to exchange data over
a different port (right click Linkman button | Preferences).

You know when you need to change the port from 80 to e.g. 81 if Linkman does not respond to the
addon clicks (should not be needed on 99% of all computers).

The communication port must be also changed in Linkman (Tools | Settings | Browser).

http://www.outertech.com/en/opera-bookmark-manager
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3.6 Synchronize bookmarks

Linkman Pro (not Linkman Lite) has improved support for online synchronization services.

You can also watch a tutorial video on  . Fast forward to minute 12:46 to watch the section
about Dropbox synchronization.

Please be aware that only Linkman Pro supports the automatic cloud syncing feature. Linkman Lite
has limited sync support if you set it up like the pro version, but is not able to detect when the
synchronization process is completed in order to reload the database! Beware of data loss when trying to
sync with Linkman Lite. Your synced data is only safe with Linkman Pro!

This tutorial explains how to set up syncing of Linkman Pro links between two computers. It has to be
done only once. After you have completed this process the syncing will work automatically, without
any clicks.

Linkman has been tested with these free services:

Dropbox (recommended) https://www.dropbox.com
Syncplicity (recommended) http://www.syncplicity.com
Google Drive (recommended) https://drive.google.com
Microsoft Onedrive https://onedrive.live.com
Live Mesh https://www.mesh.com
Spideroak https://spideroak.com
Wuala http://www.wuala.com

In this tutorial chapter you get two different guides, a 3 step guide for expert users and a 10 step guide
for novice and intermediate users.

The short 3 steps guide how syncing Linkman links works with Dropbox (expert users)

1. Select any of the syncing services above and sign up. We recommend Dropbox for expert users,
as it can be set up very quickly.
2. Install Linkman Pro and Dropbox on both computers.
3. Save your Linkman Database (*.lmd) to the Dropbox folder (e.g. C:\Document and
Settings\Administrator\My Documents\Dropbox)

Result:

Linkman Pro will detect if Dropbox (or any other sync service) changes the Bookmark Database (*.lmd)
while Linkman is running. If the user has no pending changes to save, Linkman will reload the database.

Example:

You are at your work computer and add some links to Linkman. You go home and turn on your
computer. Linkman will load, but the database will not have the links you have added at work at this
moment. Dropbox will download (without any need of user interaction) the database changed at work.
After Dropbox is done, Linkman will automatically reload the database and the new added links will
become instantly available in your browser. This works of course also if you add links to your home
computer. They will become available on your work computer.

The reload feature can be turned off in Tools | Settings | Data.

The long 10 steps guide how syncing Linkman links works with Syncplicity (novice and
intermediate users)

1. Install Linkman Pro on the first computer (you have probably done that already)

2. Either import your existing links (from IE, Firefox etc) into Linkman or create a new Linkman
database. Linkman will create a database automatically when you add a single link to Linkman directly
from the browser. You can also select the location of the database manually by using the File | Save as
function.

3. Look inside Linkman's main window where your Linkman database is located. Either remember or note
down the location of your database. In this example the database is located in the My Documents folder

https://www.dropbox.com/
http://www.syncplicity.com/
https://drive.google.com/
https://www.mesh.com/
https://www.mesh.com/
https://spideroak.com/
http://www.wuala.com/
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(default location for non-USB installations). Either remember or write down your database location.

4. Select any of the syncing services above and sign up. We recommend Syncplicity for novice users,
as it's very easy to install and configure. Visit the http://www.syncplicity.com webpage and sign up
for the free Personal Edition. After creating an account will be able to download the Syncplicity software.
Install the software. During the install process you will be asked which folders you want to share
between your two computers. Select the Let me pick folders option.

5. After the installation completes, use the Add new folder function to make your Database folder
available across two different computers.

6. Now go to your second computer and Install Linkman Pro.

7. Visit the http://www.syncplicity.com webpage and log in into the Syncplicity account.
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After login click on the install button. Download and install the Syncplicity software.

8. After the installation the Syncplicity window will show up. There you will see the Database folder that
you have shared on the first computer. Click on that folder. Now you can select a place where this folder
should be put on the second computer.

9. Go to Linkman Pro and load the database from that folder. You have to do it only once. From that
moment on Linkman will use this database automatically.

10. That's it!

Linkman's Database (*.lmd) is stored in the folder that is synced by Syncplicity. You add some links to
Linkman on the first computer. You turn on your second computer (e.g. a Notebook). Linkman will load,
but Syncplicity is not done syncing yet (because it can take up to 30 seconds), so Linkman has loaded
the database that was used before on this computer (so you don't have the new links added on the other
computer at this moment). After Syncplicity is done, Linkman will automatically reload the database and
the links added on the first computer, will become instantly available on your second computer.

This works of course also if you add links to the second computer. They will become available on the first
computer.
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Synchronize between different Linkman databases

Tools | Synchronize is used to copy non existing Bookmarks/folders from one database to another. This
function is very handy if you get a Linkman database from a friend and want to merge it with your
database. 

In the screenshot below you can see 2 databases loaded into Linkman (lmd file in the left panel, IE
Favorites in the right panel). Both have a similar Treeview structure.  

By synchronizing Right to Left Treeview Linkman copies all non existing Bookmarks/Folders while
maintaining the correct Tree structure.

Launch Tools | Synchronization.

You can decide what should happen if the Bookmark/Folder does already exist in the destination
Treeview. Linkman can add non existing data (e.g. if the Bookmark in source Treeview has keywords
and the Bookmark in destination Treeview has no keywords, the keywords will be copied) or replace all
data (which means that e.g. if the Bookmark in source Treeview has no keywords and the Bookmark in
destination Treeview has keywords, the keywords will be deleted).

In the screenshot below all non existing Bookmarks/Folder will be copied from Right to Left Treeview,
only non existing data fields will be updated.
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New folder, NewUrl2 and Folder5 have been copied from right to left panel.

You can let Linkman synchronize from multiple bookmark collections at startup (Tools | Settings |
Program start).

See First steps section for details.
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3.7 Desktop Toolbar

The Linkman Desktop Toolbar is one of Linkman's most powerful features. It allows you to store, edit,
search and launch links efficiently.

The toolbar offers numerous query and launching options. New Bookmarks can be added by using the
menu, the buttons, or drag & dropping them directly from web pages to the toolbar.

You can resize the toolbar to any dimensions you want, just put the mouse cursor to the top of it, hold
down and move the left mouse button.

It can be quickly minimized and restored (second button from the left).

You can detach the toolbar from the bottom of the screen by holding down the left mouse button and
dragging this symbol.

If you drag it to the top or bottom of your screen the toolbar will automatically reattach.
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You get several options to configure the toolbar, e.g. you can set it to Stay on Top.

If you don't want to use the Linkman Desktop Toolbar, you can disable it in the View menu.
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3.8 User interface overview

Linkman's main window consist of two panes which can be set to 3 different operational modes:
Treeview, Query and Properties. The following screenshot shows the left pane set to Treeview mode and
the right pane set to Query mode. The Query mode enables you to search for specific content in the
database that is loaded into the left pane. 
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You can switch a pane to a different operational mode using the Mode button. Either click on the icon to switch to the next
mode, or select a specific mode from the menu.
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In this example, two separate databases are loaded into Linkman, a native LMD database (mySampleLinks.lmd in this case) in
the left pane and Internet Explorer Favorites in the right pane.

Linkman can load specific databases into both panes at startup. The First Steps tutorial explains how to set it up.

You can also Drag & Drop Bookmarks and Folder between the two panes.

The next screenshot shows both the left and right pane set to Treeview mode.
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Using the Properties dialog

Select a Bookmark or Folder and launch the Properties command from the Treeview or Query list
shortcut menu. Alternatively you can press the ALT + Enter hotkey. The properties window will pop up.
All settings described here can be also accessed if you set one of main window panes to Properties Mode
(read this section for more info).

This dialog will also be shown when you add new links using the Add and edit Bookmark from browser
function (available in IE Toolbar, Tray Icon, Drop Basket and as a Global Hotkey).
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Bookmark Properties

Main Page:

The main page has the same functionality and GUI elements as the Edit Area of Linkman's main window.
Additionally you can set the Shortname, Username and Password for every Bookmark. Shortnames are
useful if you want to use the Launch fast links function. If you store Usernames and Passwords Linkman
will use them when launching the Bookmark and also make 2 additional shortcut menu functions
available (Copy username to clipboard and Copy password to clipboard).

The folder edit field will let you query for folders within the database. After making a selection in the
corresponding combobox and clicking on Ok the Bookmark/folder will be moved to the new location.

Options Page:

Ignore while checking for duplicates

Set this flag and the Bookmark will be ignored while the duplicate search

Bookmark validation queue flag

Set this flag and the Bookmark will be added to Bookmark validation queue - the icon of the Bookmark
will change to a symbol that indicates that the Bookmark will be processed when Bookmark validation
starts

Ignore page changes

Set this flag and the Bookmark page change status will be ignored while Bookmark validation, this is
useful for web pages that change on a daily basis

Page has changed since last launch

This check box is indicates that the Web Site content has changed. If checked the Bookmark caption is
underlined. You can also modify this flag by selecting the Bookmark(s) and pressing the CTRL + Y
hotkey.

Bookmark validation indicated page movement

This check box indicates that the Bookmark path has changed

Old Bookmark path

After Linkman updates the path to a new address the old path is stored in this edit box

Bookmark validation

Select here the frequency you want the Bookmark to be validated. By default the Bookmark takes this
setting from the parent folder or (if no parent folder) validates always.

Launch count

This value corresponds to the times the Bookmark has been launched from Linkman. Launch counts are
not stored by default - you can enable them in Settings | Data.

Launch with

Change the combo box value if you want the Bookmark to be always launched with a specific browser

Status Page:

Date List View

Displays the date values Linkman stores for every Bookmark.

The launch date is only displayed if Store last launch dates (Tools | Settings | Data) has been enabled.
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Http status List View

Displays the last 5 Http status codes received while Bookmark validation.

Bookmark Header Page:

Get Bookmark header from server

If you click this button Linkman will try to connect to the server and get the Bookmark header.

Folder Properties

Main Page:

The main page has the same functionality and GUI elements as the Edit Area of Linkman's main window.

Additionally the Bookmark validation combobox is available.

Select here the frequency you want the Bookmark to be validated. By default the folder takes this
setting from the parent folder or (if no parent folder) validates always.

Status Page:

Counters List View

Displays the element counts of the edited folder.
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3.9 Import & Export

Linkman allows you to import several different bookmarks formats.

If you want external bookmark files to be imported at every Linkman startup, please refer to the First
steps section of the tutorial.

You can configure default import files in Tools | Settings | Import & Export.

If you need a user definable export format you should use the Export Templates.

Internet Explorer Favorites

You can load Internet Explorer Favorites using the corresponding button in the main window toolbar or
selecting Open IE Favorites... from the File menu.

In order to save IE favorites use the corresponding button or select Save IE Favorites from the File
menu.

Firefox 2 (legacy) Bookmarks

Select the panel in which you want to import the Firefox Bookmarks. Run the File | Import | bookmarks.
html... command.
A dialog will pop up. Select your Firefox 2 bookmark file (Bookmarks.html) and click Open. Linkman
will scan your bookmark file and load the Bookmarks/Folders.

In order to export your Firefox 2 Bookmarks either select File | Export | bookmarks.html... menu
command.

Firefox Bookmarks

Select the panel in which you want to import the Firefox Bookmarks. Run the File | Import | Firefox
Bookmarks... command.

A dialog will pop up. Select your Firefox bookmark file (places.sqlite) and click Open.

Linkman will scan your bookmark file and load the Bookmarks/Folders.

Firefox does not allow write access to its database while it's running.

The only way to export Fire fox  Bookmarks from Linkman is to export them in the format of Fire fox  2 (
Bookmarks.html) first and then import manually into Fire fox .

Within Firefox: Select the Bookmarks main menu in Firefox, then go to Organize Bookmarks... | Import
and Backup | Import Bookmarks from Html and choose the Bookmarks.html file exported with Linkman.

Google Chrome Bookmarks

Select the panel in which you want to import the Google Chrome Bookmarks and run the File | Import |
Chrome Bookmarks... command. A dialog will pop up. Select your Chrome bookmark file (named
Bookmarks) and click Open. Linkman will scan the file and load the Bookmarks in the selected pane.

Chrome does not allow write access to its database while it's running.

The only way to export Chrome Bookmarks from Linkman is to saving them in the format of Internet
Explorer (Favorites) first (File  | Save as IE Favorites), and then import manually into Chrome
(Select Import Bookmarks and Settings from the main menu in Google Chrome). 

Powermarks Bookmarks

Select the panel in which you want to import the Powermarks Bookmarks and run the File | Import |
Powermarks Bookmarks... command. A dialog will pop up. Select your pm35.htm file and click Open.
Linkman will scan the file and load the Bookmarks in the selected pane.
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Opera Hotlist

Select the panel in which you want to import the Opera Hotlist and run the File | Import | Opera Hotlist...
command. A dialog will pop up. Select your Hotlist file and click Open. It usually tends to be default.adr
or Opera6.adr in the Opera installation directory. Linkman will scan your Hotlist and load the Bookmarks
in the selected pane.

Importing separated value file

Select the panel in which you want to import the File and run the File | Import | Separated value file...
command. A window will pop up. Select a file by clicking on the ... button. Assign the columns to the
values, set the delimiter and click on the Import button. You can see a detailed example how to use this
function on the end of this tutorial section.

Search in file for Bookmarks...

This function will find links in any file, no matter the format, as long as the file is not encrypted. It's
useful to import links from webpages (.htm or html files).

Select the panel in which you want to import the file and run the File | Import | Search in file for
Bookmarks... command. A window will pop up. Select the file you want to parse by clicking on the ...
button, it should be preferably a html file or txt file, but the function will work with all files. 

What is the Deep Mode?

With Deep Mode turned OFF Linkman will search for html <A HREF> tags and extract both the names and
the paths of the found Bookmarks. With Deep Mode turned ON Linkman will find any links that start with
http:// or www, but not extract the Bookmark names.

Click on the Scan button and the process will begin.
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Linkman <-> MS Excel Import/Export

On the following screenshots you can see how to export a lmd file to a Tab Separated Value (tsv) file,
import it to MS Excel, change, save and Re-Import back to Linkman.

1. Launch the tsv Export Template.

2. Select a filename and click save.
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3. Use File/Open... in MS Excel to load the Linkman generated file.
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4. After you open the file this wizard will pop up, set File origin to Windows (ANSI) and click on Finish.

5. Now you can edit the data, in this example we have added "Linkman home" as description and the
Rating of 5 to the Outertech link.

Please note that you can edit the file in a very similar way also directly within Linkman. Inside the Query
results, navigate to the data field you want to edit and press the space key.
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6. Now save the file.
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7. Launch the Import | Separated value file menu item in Linkman.

8. Set the filename and click on Import.
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9. The data is back in Linkman with changed Description and Rating.
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3.10 Search (Text Query)

From Linkman 7.0 on, Text and Status Query have been combine into one, more powerful query
function. This means Text and Status Query can be combined.

Please load the database file included with Linkman to try out the examples of this tutorial section.

Note: The query can be also performed directly in your browser and the Linkman Desktop Toolbar.

Please refer to the Firefox integration and Internet Explorer integration sections for more details.

Query functions are intended to help you find specific Bookmarks and Folders very fast. You can access

the Query functions in the Edit menu. Text Query has also a  button on the Button bar, but the best
way to access the query functions is to use the mode menu, as shown on the screenshot below.

By default the Query mode is already activated on the right side of the Linkman main window (on the left
you have the Treeview mode by default). If you have changed the display mode of the right side, you
can activate Query Mode in the menu that is shown in the screenshot below.
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Instead of a second Treeview the right panel can display Query lists or the Properties page of the
selected link/folder. To return the right panel to Treeview Mode use the same shortcut menu (the entries
differ according to panel mode) or the Return to Treeview menu item. If you use 2 Treeviews at the
same time the Swap Treeviews (Treeview main menu or CTRL + U) command may be helpful to query
the content of both databases quickly.

If you want to switch back select Treeview from the same menu.

Query settings

You can show/hide query settings by clicking on the  symbol right to the Query button.

Names, Keywords, Description, Folders, Paths, Comments, Userdef check/uncheck to select what data
fields should be searched

Autoshow if checked Linkman will show the item in Treeview if you click on an item in Query list, if
unchecked you will have to launch the Show in Treeview function in shortcut menu to get the
corresponding Treeview item

Two colors if checked Linkman will show the query results using 2 different colors, if unchecked rating
colors will be used for the results

Folder content if checked Linkman will show all child items of a folder if the folder alone matches the
search text
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Text Query examples

If you double-click a Bookmark in the Query list Linkman will launch it. 

In the screenshot below Linkman has found 17 items that contain the text hardware and the text news.
The results are sorted ascending by name (see arrow symbol in name column header). Click once on the
name column header to sort descending, click once on another column header for a different sort order.

If you want to edit any of the displayed data, navigate to the field you want to modify and press the
space key or select edit from the menu.

You can also drag & drop any of the listed results to the folders/Bookmarks on the left side (and vice
versa).
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This is a more complex example, you can currently combine the and/not and operators, but not the or/
and operators. The results are sorted by path (see arrow symbol in path column header).

Note: From Linkman 8.10 on you can limit search to specific bookmark ratings using #rating, e.g. a
search for manager #3 will display
   all bookmarks that contain the keyword manager and have a rating of 3

Note: From Linkman 7.70 on the Query Search has been improved: and search is activated by
default (instead of phrase search).

Example:

Before you had to type: hardware and news and not 3d
Now it's enough to type: hardware news not 3d

If you want to search for a the phrase hardware news type "hardware news".

The old search methods are still accepted.

You can also replace not with the . sign: hardware news -3d

Note: From Linkman 7.50 an additional query feature has become available: When searching for
multiple terms, name and keywords of  the parent folder will be taken into consideration for every link
inside.

Example: 

You have a folder called music with several links inside. Some of these links have the keyword software.
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If you search for music software all of these links will be found, even if they don't possess the music
keyword.

So if you want to add a keyword to several links at once, simply at the keyword to the folder that
contains these links instead. This works also with folders, to add a keyword to multiple folders at once,
add it to the parent folder that contains these folders instead.

You can use wildcards in the query text.

Examples:

3d will show all items containing the text "3d" (Linkman converts 3d internally to *3d*).

3d ne ws will show all items containing the text 3d and the text news (Linkman converts 3d news
internally to *3d* and *news*).

"3d  ne ws" will show all items containing the phrase 3d news.

3d o r  ne ws will show all items containing the text 3d or the text news (Linkman converts 3d or news
internally to *3d* or *news*).

3d?w will show all items containing "3d" followed by any single char and w (e.g. 3D World)

3d?s*surge will show all items containing "3d" followed by any single char, followed by "s" and
containing "surge" somewhere thereafter (e.g. 3D Sound Surge) 

% 3d will show all items beginning with the text "3d".

3d%  will show all items ending with the text "3d".

manager #3 will display all bookmarks that contain the keyword manager and have a rating of 3

The next screenshot shows all items beginning with "3d".

If you want to launch multiple Bookmarks at once, hold down the SHIFT key and mark them. Then
select Launch selected Bookmarks  from the right click menu.



Tutorial

73Linkman

You can launch the Bookmarks from every folder in the shortcut menu.
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3.11 Search (Status Query)

This mode is similar to Text Query. It can display specific items, for example all web pages that have
changed since last Bookmark validation or all folders.

Select Status Query from the panel mode menu.

The Query list in the screenshot below shows all folders of the left panel Treeview.  
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If you double-click a Bookmark in the Query list Linkman will launch it.

The screenshot below shows all Bookmarks with the Bookmark validation Page moved flag.
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The copy menu is only shown if you hold down the CTRL key while right clicking the Query list item(s)
(as in the Treeview shortcut menu).

On the next screenshot you can see the Duplicates section of Status Query.
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3.12 Drag & Drop

You can drag & drop selected items to a new location within the Treeview. 
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You can also drag & drop items between 2 Treeview panes. The 2 panes are independent datasets. By
default Linkman copies the items to the opposite Treeview pane. If you want to move the items, change
the Move instead of copy setting in Tools | Settings | Interface. You can also turn on/off this setting by
pressing the CTRL + M hotkey.

If you want to drag & drop within the same Dataset (= Treeview = Database), but still use 2 panels, set
the right panel to Query mode. (See Status query for more info). 
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The next screenshot shows the left panel in Treeview mode, the right panel in Status Query/Folders
mode of the same dataset. By drag & dropping you can move the links to a new folder within the same
lmd file.

This works of course also the opposite way, in the screenshot below 3 items from Text Query list are
moved to a new folder.
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Drag & drop works not only within Linkman, but also from your browser to Linkman and the Linkman
Drop Basket.

Drag & Drop from browser to Linkman works with Internet Explorer, Firefox, Mozilla, Avant Browser,
Neoplanet, Netcaptor and MyIE2. The Opera browser does not support drag & drop between applications.

The next 2 screenshots show the different Drag & Drop possibilities. In Internet Explorer you can also
drag & drop links to the Linkman Toolbar if you want to add them to Linkman.
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3.13 Add new links

Note

When searching for multiple terms, name and keywords of the parent folder will be taken into
consideration for every link inside.

Example:

You have a folder called music with several links inside. Some of these links have the keyword software.
If you search for music software all of these links will be found, even if they don't possess the music
keyword.

So if you want to add a keyword to several links at once, simply at the keyword to the folder that
contains these links instead.

This works also with folders, to add a keyword to multiple folders at once, add it to the parent folder that
contains these folders instead.

1. Manual addition

Select the New | Bookmark command from the shortcut menu, click on the corresponding  button or
press the Ins key.

A new item called New Bookm ark will appear in the Treeview.

You can immediately change the name of the Bookmark. It could be anything meaningful to you like 
Oute rtech or My  First Bookm ark.  Enter the Bookmark address in the Path edit box e.g. http://www.
oute rtech.com , optional keywords and a comment.

If a folder is selected Linkman will attach the new Bookmark to the folder, if you want to insert the
Bookmark above the folder hold down the SHIFT key while executing this command. To insert the
Bookmark below the selected item, hold down the CTRL key.

Click on the rating bar to rate the Bookmark. You can also use the CTRL + 0-5 hotkeys.
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You will now see the new Bookmark with the color of the rating you have given it. You can configure
rating colors, caption and other settings in Tools | Rating color configuration... as explained later in the
Configuration section of this Tutorial.

To access all Bookmark or Folder properties you can show the Properties dialog.

For properties description please refer to this section.
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If you need faster properties access you can turn one the two Linkman panes into Properties mode.
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..and hide the main Edit Area.
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2. Addition from browser

In the beginning you must define a destination for the Bookmarks received from browser.  Please go to 
Tools | Settings | Receive Bookmarks and configure it according to your preferences.

Linkman will add the received Bookmark(s) to the defined destination with one exception: If you use
the Add from browser menu item within the Linkman main window (Treeview or Query list shortcut
menu and Bookmark main menu) the Bookmark will be added to the selected item. If you launch the
Add from browser function outside the main window (Tray Icon action, Tray Icon menu, Drop Basket
action, Drop Basket menu, Hotkey, Internet Explorer Toolbar) Linkman will add the Bookmark(s) to the 
defined destination. 

You can use the right click menu of Internet Explorer or Firefox or to add the current webpage to
Linkman.
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Please refer to the Internet Explorer integration and Firefox integration sections for more details.

The Add from browser menu item is only visible if Linkman finds at least one window of the supported
browsers. If you use an Internet Explorer clone that Linkman does not support directly you must use 
Drag & Drop instead.

The screenshot below shows the Add Bookmark from browser function in the Treeview shortcut menu.
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The next screenshot shows the Add Bookmark from browser function in the Query list shortcut menu.

The Add Bookmark from browser... window can be launched from several places -  the Button bar 
symbol, the Bookmark main menu, the Tray and Drop Basket menu and a configurable global hotkey.
The function opens a new window with a list of all available browser Bookmarks. You can add several
Bookmarks at the same time. The Add Bookmark from browser... window displays also the Bookmark
stored as text in clipboard.
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The screenshot below shows the Linkman Internet Explorer Toolbar. The Add and edit function will
display the Properties dialog after the addition.
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3. Drop Basket and Tray Icon

In the next 2 screenshots you can see how to add Bookmarks directly to a folder without showing
Linkman's main window. 
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You can configure the Drop Basket functionality in Tools | Settings | Drop Basket, for example you can
assign the Add Bookmark from browser function to a double-click on the Drop Basket window. To change
the Tray Icon click events go to Tools | Settings | Tray Icon.

Tip

The Linkman tray icon can change its color to indicate a status change:

Red Icon normal operation mode
Purple Icon Linkman is loading or saving a bookmark database file
Green Icon Linkman has just synchronized a bookmark file using an external synchronization service
like Dropbox or Google Drive. The Icon will stay green until a new bookmark is added, or an existing
deleted.

4. Hotkeys

You can activate up to 10 external hotkeys to access Linkman while working with other programs. For a
detailed description of hotkeys please refer to this section.
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3.14 Launch links

Linkman offers many methods to launch Bookmarks.

1. Directly in your browser

Use the search function in the right click menu of your browser.

Enter the search text into the edit box. To  launch the first result press enter. Alternatively you can
double-click a Bookmark in the list. Double-clicking a folder will launch the folder content as tabs.
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2. Tray Icon and Drop Basket

Use the Launch History
Browse the Left Tree and Right Treeview menus, click on a Bookmark to launch it, use the launch
Folder content function to launch multiple Bookmarks at once
Select the Launch Bookmark in Clipboard menu item (hidden until a Bookmark lands in clipboard)
Use Fast or Daily Links

3. Within main window

Double click a Bookmark in the Tree
Press enter: the selected Bookmark will be launched
Select Launch from menu (Bookmark and shortcut menu)
Select Launch in new window with (Bookmark and shortcut menu)
Select multiple Bookmarks and use the Launch selected Bookmarks function from the right click menu
Select Advanced Launch (Bookmark menu)
Use the Launch History (Bookmark menu and Status Query)
You can also launch all Bookmarks within a Folder (Bookmark and shortcut menu)
Use Fast or Daily Links

Launch configuration

At the beginning you should check if Linkman has detected your browser paths correctly. Go to Tools |
Settings | Browser.

In the screenshot below you can see Winamp 3 is set as user defined browser. This way you can play
Winamp streams in Linkman's Tray Icon or Drop Basket.

In the next step you should select your default browser (Launch Bookmarks) and the launch options.

Bookmark Path associated launch is designed to associate specific path content with a browser. Some
web sites may not work with your default browser correctly, e.g. the Microsoft website is known to work
correctly only with the Internet Explorer. You can configure Linkman to launch all Bookmarks with Firefox
except the ones containing the text Microsoft.
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Internet Explorer "forgets" sometimes the size of the window, with Linkman you can avoid this
annoyance.

You can configure also every single Bookmark to launch with a specific browser as seen in the
screenshot below.
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By default you can launch a Bookmark with a double-click. If you hold down the SHIFT key while
launching a Bookmark Linkman will hide to tray after the Bookmark has been started. In case you have
disabled the double-click in settings you can use the launch functions of the shortcut menu. 
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Linkman can launch multiple Bookmarks with a single click.

You can also launch all Bookmarks inside a folder.

The Launch History can be accessed in Bookmark menu, Tray Icon, Drop Basket menu and Status
Query. To configure maximum History items or disable the Launch History (by setting max items to 0) go
to Tools | Settings | Tray Icon.
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The screenshot below shows the Launch History in the Tray Icon menu.

Linkman can also open a new browser window with the Bookmark placed in clipboard. The menu item is
available in the Tray Icon and Drop Basket menu, but only visible if Linkman finds a valid Bookmark (e.
g. text starting with http:// or www.) in clipboard.

On the screenshot below you can see the Drop Basket menu with the mentioned menu item. For more
details please refer to the Drop Basket tutorial.
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Internet Explorer Toolbar

With the Linkman IE Toolbar you can access your Linkman database in a matter of seconds. Just type in
the search terms (you can use the or, and, not and operators). Press enter to launch the first result, or
select the Bookmark from the combo box. The IE Toolbar has an extra section in this Tutorial.
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Fast Links

Fast Links is a list of your most important Bookmarks. Linkman gives you the ability to access this list
from several places.

You can modify all your Fast Links using the Fast Links | Edit... function.

Linkman contains already 3 example Fast Links after the installation. To add more Fast Links select the
Bookmark(s) and launch the Fast Links | Add selected items command or right-click the selected entries
and click Add to Fast Links from the shortcut menu that appears. You can also add complete folders to
Fast Links.

You can access Fast Links thru the Fast Links | Launch menu item, the Fast Links button drop-down menu
(on the Button bar), in the Tray Icon shortcut menu, the Drop Basket shortcut menu and the Internet
Explorer Toolbar.

The screenshot below shows Fast Links in Tray Icon menu.

Fast Links can be also started using the Launch Fast Link function (Fast Links menu or Global Windows
Hotkey configurable in Settings | Hotkeys). Enter the name of the Fast Link and hit enter. Additionally,
instead of a Fast Link name you can type the Shortname of any Bookmark, as seen in the screenshot
below.
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Daily Links

If you visit some sites regularly during the course of the day then this feature is just for you.

Adding a Bookmark to your Daily Links is easy. Select & Right-click the Bookmark(s) in the Treeview
and click the Add to Daily Links item from the shortcut menu that appears.

Continue adding Bookmarks to the Daily Links till you have your group of sites you visit regularly.

From now on whenever you want to launch these sites, you just need to run the Daily Links | Launch
command or Launch Daily Links from the Tray Icon shortcut menu or the Drop Basket shortcut menu.
This will launch all these web pages in one click.
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The screenshot below shows the according menu item in the Drop Basket shortcut menu.

You can modify all your Daily Links using the Daily Links | Edit... function.

Why does Linkman not store Bookmark launch dates?

Enable launch dates storage in Tools | Settings | Data.
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3.15 Drop Basket & Tray Icon

The Drop Basket is a special Linkman window that is always on top of other applications.

You can activate the Drop Basket in the View menu.

If you close the Linkman main window, the Drop Basket will still stay on the screen. To move this window
to a different position click on it with the left mouse button and keep the button pressed while moving the
mouse.  You can access some of Linkman functions in the shortcut menu of the Drop Basket.

If you don't want to use the Drop Basket simply turn it off by unchecking Visible (as seen on
screenshot).

To configure the Drop Basket mouse click events and image go to Tools | Settings | Drop Basket. The
Linkman Tray Icon mouse clicks can be configured in the same way (Tools | Settings | Tray Icon).
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By default the Drop Basket is configured in this way:

Double click: Add Bookmark from browser (destination can be configured in Tools | Settings | Receive
Bookmarks)

Right click: Display menu

You can drag & drop Links (both Internet and local files) from Internet Explorer, Firefox and some other
browsers to the Drop Basket to add them to Linkman.
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You can set the destination of the dropped links in Tools | Settings | Receive Bookmarks.

Tray Icon

The Linkman Tray icon has comparable functionality to the Drop Basket (see above) minus Drag & Drop
and free positioning.

You can configure what should happen on a single left, double left and right click on the Tray Icon (Tools
| Settings | Tray Icon).

By default the Tray Icon is configured in this way:

Single click: Open new browser window (which browser should be opened can be set in  Tools | Settings
| Launch Bookmarks).

Double click: Hide/Unhide Linkman (main window)

Right click: Display menu (see screenshot below)
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Why can't I see all Tree items in the Tray Icon / Drop Basket Treeview menus?

By default Linkman limits every sub-menu to 40 items to speed up menu drawing. Go to Tools | Settings
| Tray Icon to set the maximum number of Bookmarks which should be visible in the Tray and Drop
Basket Tree menu. 

How to disable Bookmark History?

Go to Tools | Settings | Tray Icon and set max items to 0.
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3.16 Configuration

1. Global Settings

Linkman is extremely configurable. To get the explanation for a specific option use the context sensitive
help. Click on the ? button located in the right upper corner of the settings window. The cursor shape will
change to a ? symbol.  Now click on a GUI element to get the description text.

If you modify something and want to restore you old setting click on the Cancel button, the dialog will be
closed and the settings will be NOT stored.

What is the Try button for?

You may want to check out some options without making the changes permanent - e.g. change the
background color of the Treeview panes. To do this perform the following steps:

Go to the Interface section
Select Tree background from the combo box in the Colors section
Change the color by clicking on the Palette button

Click the Try button - you will see the Treeview panel will change its color immediately.

If you don't like the color and want your original color back simply press the Cancel button and Linkman
will restore your original settings.

Receive bookmarks date format

When adding multiple bookmarks at once from a web browser Linkman will create a new folder for the
new bookmarks. The caption of the folder is configurable.

%name% will be replaced with the name of the first bookmark added to the folder (usually the first tab
in the browser).

Additionally date tokens can be used. If you don't want a text to be formatted at all, place it in quotation
marks. For example "yy " will create a folder with the name yy. "yy "dd will create a folder with the name
yy05 (if you are on the 5th day of the month).
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2. Treeview properties

You can access the Treeview properties in the Treeview main menu and the Tools menu (Rating color
configuration...).

On the Ratings page you can configure the rating system for the current and all new databases. Set the
minimum, maximum allowed Ratings, the colors and captions for every Rating point. By clicking the 
Default for new files section Linkman will remember the configuration and use it for new databases. You
should always check this checkbox if you want to use Ratings for Internet Explorer Favorites!

You can save and load the rating system configuration to templates and also restore the default
configuration (Set to default).

On the User defined page you can set labels for the User defined fields of the current database.

In the example below we have set Language as label for the first alphanumeric field.
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After clicking on Ok you see the change immediately in the properties section of the Bookmark.
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3.17 Bookmark validation

If you want Linkman to dial a DialUp Connection or to access the internet over a proxy server please set
the corresponding values in the Connection page of the Settings window (Tools | Settings). 

If you do not want to validate the whole Treeview, select the Bookmarks and Folders you want to
process. (Linkman will validate the content of all selected Folders). Launch Bookmark validation & Page

changed check... command from the Tools menu or click on the corresponding  button. A new window
will pop up.

Options explained

Simultaneous requests

Set the amount of Bookmarks linkman should check at the same time. This setting should be low for a
slow Modem connection (3-5) and high for a fast connection like cable modem or ADSL (5-20).

Store old Bookmark paths for .. days

If Linkman updates the path of a moved Bookmark you can define the numbers of days the old
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Bookmark path should be stored. If you want to store the old path without a time limit set this value to 0.

Timeout 

If the server has not sent any new data in x seconds, Linkman will break the connection and step over to
the next Bookmark. Note that the domain of the Bookmark is not present at all (not registered) Linkman
will immediately time out for this Bookmark.

Check only selected items

Check this box if you do not want to validate the whole Treeview, but only the selected Bookmarks and
folders.

Check only invalid items

Check this box if you do not want to validate the whole Treeview, but only the timed out and not found
items.

Check for pages changes

Check this box if you want Linkman to examine if the content of the corresponding web page has been
changed since the last Bookmark validation. 

Report only major changes

With this option turned on Linkman will try to ignore small changes on web pages (like dates).

Ignore page movements within the same domain

When enabled, Bookmark paths will not be updated if the path changes, but does not leave the old
domain.

Update moved pages

Check this box if you want Linkman to update the Bookmark path if the web page has moved to a new
location.

Update keywords

If checked Linkman will extract the keywords from metatags of webpages and update the keywords data
fields.

Replace descriptions

If checked Linkman will replace the description data fields with the description found in metatags of the
webpage (if any).

Retrieve missing names

Example:

Bookmark Name: Outertech
Bookmark Path: http://www.outertech.com

If this option is checked, Bookmark Validation will change the Bookmark Name to the title of the
webpage:

Outertech - computer memory and cache optimization, tuneup and internet utility software

The replacement will be only done if the Bookmark Name is not present or is similar to the Bookmark
Path.

Replace all names

If checked Linkman will replace Bookmark Names with webpages titles. The replacement will be always

http://www.outertech.com
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done.

Colorblind status icons

When enabled, Treeview icons will be replaced with another set that is better suited for colorblind users.

Custom metatags

Here you can enter two custom metatags which will be extracted from the websites and placed to your
desired user defined fields of every Bookmark.

Validation process

After a click on the Start button the validation process begins. 

As you see the Bookmark icons have changed.

The Bookmark is placed on Bookmark validation queue and awaits to validation.

Linkman validates this Bookmark at the moment.

All ok: Linkman could successfully get the web page.

Page moved: The web page has moved, the Bookmark path has been updated, the old path can
be found in the Bookmark Properties dialog.

Page not found: The request for the web page was NOT successful, the page is probably offline
or you have no authorization for it. You can look into Bookmark Properties to see the exact status code.

Connection timed out: The server has NOT responded at all within the desired time. The timeout
value can be set in Bookmark validation dialog.

Transaction timed out: The server has responded to the request, but the connection has timed
out during the transfer of the web page.
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While the validation proceeds you can still manipulate the Treeview.

After the validation process

At this moment you surely want to see the results. Linkman will help you in accessing the validated
items.

To see all Bookmarks with a special status use the Status Query function as shown on the screenshot
below.

You can stop the Bookmark validation at any time, save the file and resume the validation the next time
you are working with Linkman.

Linkman tries to be very exact with Bookmark validation. The World Wide Web consist of billions of web
pages, so there will be always some that will not work correctly with specific browsers or Linkman. If you
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find a web page that Linkman reports wrongly as not available please send the Bookmark to . 
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Page content changes

Linkman will indicate pages changes by underlining the Bookmark names.

You can also manually modify the 'page changed flag' by selecting the Bookmark(s) and pressing the 
CTRL + Y hotkey. If you have Store launch dates enabled (disabled by default - go to Settings | Data to
modify it) Linkman will clear the 'page changed flag' if you launch the Bookmark to visit the page.

Tips

Best use of the Check for page changes feature

Linkman will indicate that many pages have changed after every Bookmark validation (except of the first
validation where no changes can be reported), but if you visit some sites you will see no significant
change. What is the reason for this? 

There are many pages available that change on every access - not the content of the page changes, but
some statistical data, time stamps, visit-counters, advert links etc... Linkman removes by default most of
this information, but it's impossible to be 100% exact in this process. It would be best to exclude the
sites where Linkman reports a change on every Bookmark validation from the page change check (but,
not from the validation itself).

You can perform this by turning on the Ignore page changes flag in the Properties dialog of every
Bookmark. This would be a pain for more than 10 Bookmarks, but there is a trick to do it the easy way:

1. Validate the whole Treeview
2. Validate the whole Treeview immediately thereafter

Linkman will underline some Bookmarks - they do most probably belong to the described category of
always changed sites (unless the page has really changed within the last minutes).

Use the Status Query to show all changed pages.

Select all Query items (CTRL + A Hotkey or shortcut menu item) and use the Set status function (Tools
menu) to turn the Ignore page changes flag on.

Now, after a Bookmark validation you can be sure that the underlined webpages have new content.

In the lmd file included with Linkman some Bookmarks have already the Ignore page changes flag
turned on.
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3.18 Export Templates

Export Templates are useful if you want to export your Bookmark collection in a format that Linkman
does not support directly. 7 Template examples are already included - 5 HTML, one TSV (Tab Separated
Values) and one XML template.

To test the Template functionality go to the File | Export | Template menu or use the   button menu
and select one of the Templates from the submenu. 

A save dialog will pop up and after you type in the name Linkman will save the active Treeview in the
selected format.

On the screenshot below you can see the output of Html Example Template 4 in Internet Explorer:

Linkman can automatically save a template file when saving a lmd file (configure in Tools | Settings |
Data).
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How to create a Template?

With this example you will create a CSV (Comma Separated Values) Template that is not included with
Linkman.

You can show the Linkman Export Templates window by selecting File | Export | Edit Export Templates or

clicking on the  button.

A window will pop up - you will see a small Button bar and a List View containing the 6 example
Templates.

To create a new Template click on the New Template... button.

After you enter m y  first tem pla te  as name the Template Editor window will show.

You will see 6 different pages - the first page is for description and configuration purposes, the remaining
5 pages contain the Template code.

When Linkman saves a template it processes the code from Header page, following by the other pages,
the Footer page will be processed as last.

1.

You should now describe and configure the Template.

replace the Linkm an Export Tem pla te text with some other text like This is  m y  first tem pla te  description.

change

Default Ex tension=

to

De fault Ex tension=csv

with this change Linkman will use this extension for the files exported with this template.
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2.

Activate the Header page.

enter the following text (without the snip lines):

---------------------------------- snip ----------------------------------

Nam e;Path;Com m ent;Rating

---------------------------------- snip ----------------------------------

since this is the Header, Linkman will add this text to the top of the exported file.

3.

Activate the Main Body : First Pass page.

Select Folder from the combo box.

enter the following text (without the snip lines):

---------------------------------- snip ----------------------------------

<FOLDER .NAME>,,<FOLDER .COMMENT>,<FOLDER .KEYW ORDS>,<FOLDER .RATING >

---------------------------------- snip ----------------------------------

<FOLDER .NAME> is a so called Linkman Tag. When saving the template Linkman will replace this Tag
with the actual name of every processed folder. You can add additional Tags like Time and Date or the
User defined data in the Add Linkman Tag menu.

4.

Select Bookmark from the combo box.

enter the following text into the every Bookmark section:

<Bookm ark .NAME>,<Bookm ark .PATH>,<Bookm ark .COMMENT>,<Bookm ark .KEYW ORDS>,<Bookm ark .
RATING >
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Linkman will process this code with every Bookmark in the Tree and replace the tags with the data - e.g.
<Bookmark.PATH> will be replaced with the content of the Bookmark path.

Now close the window - Linkman will ask you whether to save the changes or not - answer with Yes.

You have successfully created your first Template - you can try it out immediately!

To learn more about Export Templates study the code of the 5 included Html Templates.

Internal Html

You can also create a template from the Internal Html Output settings. (Tools menu). The internal Html
Output can be configured in Linkman's settings dialog. (Tools | Settings | Html Output).

Description-section tags

Separate file for every root folder checkbox

When checked Linkman will not save to one file, but create multiple template files. A separate file will be
created for every root folder (filename will consist of folder name + default extension). 

Default Extension

This extension will be used in the file dialog and for the template written with a lmd file (see Tools |
Settings | Data in main menu).

Default Path

Default path for the file dialog.

Default Filename
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This filename will be used in the file dialog and for the template written with a lmd file (see Tools |
Settings | Data in main menu).

ResetUrlCounter/ResetChildFolderCounter

These settings are related to the Main Body | Bookmark | Every .. Bookmarks section and Main Body |
Child Folder | Every .. folders sections. If set to Yes Linkman will reset the counters to 0 on the beginning
of every folder/root folder.

Format

You can create not only Latin1, but also UTF-8 templates.

Add this line to the template description page:

Form at=UTF-8

and all text will be converted to UTF-8.

The included XML example template generates UTF-8 text.

Linefeeds

If set to No Linkman will convert all linefeeds to <br> tags.

DateTimes

If set to Yes Bookmark Dates will be saved as Date + Time, if set to No only Dates will be saved.

CommentsToDescription

If set to Yes <Bookmark.DESCRIPTION> will be replaced with Comments if the Description data field of
the Bookmark is empty.
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3.19 Hotkeys and Shortcuts

1. Global Hotkeys (which means they work also in your browser and other programs)

Go to Tools | Settings | Global Hotkeys.

To create a new Hotkey combination:

The following instructions will show you how to configure Linkman so that the Add Bookmark from
browser function will get assigned CTRL + ALT + G key combination. Other Linkman function can be
configured in a similar fashion.

Run the Tools | Settings command or press the CTRL + T key. The Settings window will pop up. Go to
the Global Hotkeys page.

Click on he Add Bookmark from browser entry. Active, CTRL and ALT check box should be checked. All
other checkboxes should be de-selected. Select G from the combo box.

Click Ok to save the Hotkey combination. From now on anytime you want to run the Add Bookmark from
Browser command, you just need to press the CTRL + ALT + G key combination.
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De-activate a Hotkey:

Run the Tools | Settings command or press the CTRL + T key. The Settings dialog will pop up. Go to the
Global Hotkeys page and select the Add Bookmark from browser entry thereafter.

De-select the Active check box. Click Ok to save the changes. The CTRL + ALT + G hotkey has been
disabled.

2. Local Hotkeys

Browser Search window (Firefox integration , Internet Explorer integration and Desktop Toolbar).

Browser Search window | Query Edit

Enter Launch first link or folder content
ALT + Enter Show properties dialog for first link or folder
CTRL + Enter Show keyword list window
CTRL + Space Show keyword list window
CTRL + Backspace Remove last word

Arrow Down Go to Query List

SHIFT + Arrow Up Browse search history
SHIFT + Arrow Down Browse search history

Esc C lear text, if there is no text close the window (which means a double escape press deletes the text,
then closes the window)

Browser Search window | Query List

SHIFT + Mouse click Add all links/folders between selected link/folder and clicked link/folder to
selection
CTRL + Mouse click Add link/folder to selection

Mouse doubleclick Launch selected link(s) and folder(s) contents
ALT + Mouse doubleclick Show properties dialog for the first selected link or folder

Space Edit focused cell

Enter Launch selected link(s) and folder(s) contents
ALT + Enter Show properties dialog for the first selected link or folder
CTRL + Enter Go to Query Edit
CTRL + Backspace Remove last word

Arrow Up when at top row Go to Query Edit

Esc Go to Query Edit

SHIFT + Arrow Right Increase link rating
SHIFT + Arrow Left Decrease link rating

CTRL + A Select All
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CTRL + I Insert new folder
CTRL + ALT + I Insert new child folder

CTRL + Rightclick Show Copy menu

CTRL + C Copy
CTRL + X Cut
CTRL + V Paste 

Main Linkman window

Main window | Query Edit

Enter Launch first link or folder content
ALT + Enter Show properties dialog for first link or folder
CTRL + Enter Show keyword list window in order to search for a keyword
CTRL + Space Show keyword list window in order to add a keyword to the selected bookmark or folder

Arrow Down Go to Query List

CTRL + Arrow Up Focus Keyword edit box
CTRL + Arrow Right when at the end of the text Go to Query Type Combobox

SHIFT + Arrow Up Browse search history
SHIFT + Arrow Down Browse search history

Esc C lear text

Main window | Query List

SHIFT + Mouse click Add all links/folders between selected link/folder and clicked link/folder to
selection
CTRL + Mouse click Add link/folder to selection

Mouse doubleclick Launch selected link(s) and folder(s) contents
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ALT + Mouse doubleclick Show properties dialog for the first selected link or folder

Space Edit focused cell

Enter Launch selected link(s) and folder(s) contents
ALT + Enter Show properties dialog for the first selected link or folder

CTRL + Enter Show keyword list window in order to search for a keyword
CTRL + Space Show keyword list window in order to add a keyword to the selected bookmark or folder

Arrow Up when at the top row Go to Query Edit
CTRL + Arrow Up Go to Query Edit

CTRL + Arrow Left Go to Treeview

Esc Go to Query Edit

CTRL + 0..5 Set item rating
SHIFT + Arrow Right Increase link rating
SHIFT + Arrow Left Decrease link rating

CTRL + A Select All

CTRL + I Insert new folder
CTRL + ALT + I Insert new child folder

CTRL + Rightclick Show Copy menu

CTRL + C Copy
CTRL + X Cut
CTRL + V Paste 

Main window | Treeview (some of these hotkeys work also outside the Treeview, e.g. CTRL + F for
search works everywhere)

SHIFT + Mouse click Add all links/folders between selected link/folder and clicked link/folder to
selection
CTRL + Mouse click Add link/folder to selection

Mouse doubleclick Launch selected link or open selected folder
SHIFT + Mouse doubleclick on a folder Launch folder content
ALT + Mouse doubleclick Show properties dialog for the first selected link or folder

Arrow Up when at the top row Go to Edit Area
CTRL + Arrow Up Focus Keyword edit box
CTRL + Arrow Right Go to Query List

Space Rename

CTRL + F Shows Search window

F1 Help
F2 Rename
F3 Find/Find Next in Treeview
F4 inside search edit: Go to search history
F4 outside search edit: Focus Left Side
F5 Focus Right Side
F6 Focus Comment memo
F7 Insert new folder
F8 Focus Query edit
F9 Focus Query list
F11 Focus Edit Path

Enter Launch Bookmark
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CTRL + Enter Show keyword list window in order to search for a keyword
CTRL + Space Show keyword list window in order to add a keyword to the selected bookmark or folder

ALT + Enter Show Properties dialog

Insert Insert new link

SHIFT + Left arrow Decrease rating of selected item
SHIFT + Right arrow Increate rating of selected item

CTRL + 0..5 Set item rating

CTRL + C Copy
CTRL + X Cut
CTRL + V Paste 

CTRL + A Select All
CTRL + E Expand selected folders
CTRL + D Advanced Launch
CTRL + F Shows Search window
CTRL + G Collapse Treeview
CTRL + H Shows Synchronization window
CTRL + I Insert new folder
CTRL + . Insert new child folder
CTRL + + Expand Treeview
CTRL + K Set status
CTRL + L Sort
CTRL + M Change Move instead of Copy status
CTRL + N New
CTRL + O Open
CTRL + P Print
CTRL + Q Switch between Treeview and Query mode
CTRL + W Collapse selected folders
CTRL + R Search & Replace
CTRL + S Save
CTRL + T Show Settings window
CTRL + J Swap Treeviews - works only when both panels are not busy (loading, Bookmark validating
etc...)
CTRL + Y Modify the 'page changed flag' by selecting the Bookmark(s) and pressing this hotkey

Edit Area (all controls)

Enter Go to next edit

Arrow Up Go to the control above
Arrow Down Go to the control below

Edit Area (Edit Name, Path and Keywords)

Arrow Down when in Edit Keywords Go to Treeview
CTRL + Arrow Down Go to Treeview

CTRL + Arrow Right when at the right end of an edit field Go to right Edit Area (Comment etc)

Edit Area (Comment, Description, User defined tabs)

CTRL + TAB Go to next tab (page)

CTRL + Arrow Down when at the bottom of a memo Go to Query Edit

CTRL + Arrow Left when at the beginning of an edit field Go to left Edit Area (Name,Path etc)
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4 How to...

4.1 Add links

Select the New | Bookmark command from the shortcut menu, click on the corresponding  button or
press the Ins key.

A new item called New Bookm ark will appear in the Treeview pane.

You can immediately change the name of the Bookmark. It could be anything meaningful to you like 
Oute rtech - Linkm an's hom e or My  First Bookm ark. 

Enter the Bookmark in the Path edit box e.g. http://www.oute rtech.com

Click on the Rating bar to rate the site. You can also use the CTRL + 0-5 hotkeys.

You will now see the new Bookmark with the color of the rating you have given it.

To learn how to add Bookmarks directly from your browser go to this section.

Tip

If a folder is selected Linkman will attach the new Bookmark to the folder, if you want to insert the
Bookmark instead hold down the SHIFT key while executing this command. To insert the Bookmark
below the selected item, hold down the CTRL key.

Note

When searching for multiple terms, name and keywords of the parent folder will be taken into
consideration for every link inside.

Example:

You have a folder called music with several links inside. Some of these links have the keyword software.
If you search for music software all of these links will be found, even if they don't possess the music
keyword.

So if you want to add a keyword to several links at once, simply at the keyword to the folder that
contains these links instead.

This works also with folders, to add a keyword to multiple folders at once, add it to the parent folder that
contains these folders instead.
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4.2 Add folders

Inserting

To add a new folder select the New | Folder command from the shortcut menu, Edit | New | Folder from

the main menu, click on the corresponding  button or press the CTRL + I or F7 hotkeys.

Linkman will insert the new folder below the selected folder. If you want to insert the folder above the
selected item, hold down the SHIFT key while executing this function.

Attaching

To attach a folder as a subfolder select the New | Child folder command from the shortcut menu, Edit |
New | Child folder from the main menu,  or press the CTRL + .  hotkey.

Linkman will attach the new folder as the last item of the selected folder. If you want to attach the folder
as the first item, hold down the SHIFT key while executing this function.

Note

When searching for multiple terms, name and keywords of the parent folder will be taken into
consideration for every link inside.

Example:

You have a folder called music with several links inside. Some of these links have the keyword software.
If you search for music software all of these links will be found, even if they don't possess the music
keyword.

So if you want to add a keyword to several links at once, simply at the keyword to the folder that
contains these links instead.

This works also with folders, to add a keyword to multiple folders at once, add it to the parent folder that
contains these folders instead.
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4.3 Add separators

Select the New | Separator command from the shortcut menu. A new separator will be added to the
selected position in the Treeview.
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4.4 Cut, Copy & Paste

To select multiple items at once click the items with the left mouse button while holding the SHIFT or the
CTRL keys - just the same way as in the Windows Explorer. 

Cut

available in Edit menu, Treeview shortcut menu, Cut button and the CTRL + X hotkey

Cursor positioned in the Edit Area:

The selected text will be cut and stored in the Windows clipboard.

Cursor positioned in the Treeview:

The selected items will be cut and stored in the internal Linkman buffer, the Bookmark paths will be
stored in the Windows clipboard.

options:

hold down the SHIFT key: appends to internal Linkman buffer and the Windows clipboard

hold down the CTRL + ALT key: instead of paths only also Bookmark names will be stored in the
Windows clipboard

hold down the CTRL + LEFT WIN keys: instead of paths only also Bookmark names and comments will
be stored in the Windows clipboard

Copy

available in Edit menu, Treeview shortcut menu, Copy button and the CTRL + C hotkey

Cursor positioned in Edit Area

The selected text will be copied to the Windows clipboard.

Cursor positioned in Treeview

The selected items will be copied to the internal Linkman buffer and the Windows clipboard.

options:

hold down the SHIFT key: appends to internal Linkman buffer and the Windows clipboard.

hold down the CTRL + ALT key: instead of paths only also Bookmark names will be stored in the
Windows clipboard

hold down the CTRL + LEFT WIN keys: instead of paths only also Bookmark names and comments will
be stored in the Windows clipboard

If you hold down the CTRL key while right clicking the items an additional copy menu will be available:
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Paste

available in Edit main menu, Treeview shortcut menu, Paste button and the CTRL + V hotkey

Pastes the entries which has been previously cut or copied to the buffer to the selected position of the
Treeview.

Cursor positioned in Edit Area

Paste command is only available if the Windows clipboard contains some text. 

Cursor positioned in Treeview

Paste command is only available if the internal Linkman buffer contains at least one Bookmark, folder or
separator. 

Tip

If a folder is selected Linkman will paste into the selected folder, if you want to insert the buffered items
before the selected folder hold down the SHIFT key while executing this command. To paste below hold
down the CTRL and WINDOWS keys.
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4.5 Delete links

Select Delete from the Treeview shortcut menu or press the Del key. A confirmation dialog will pop up.
You can disable the confirmation on the Interface page of the Settings window. You can also configure
the Del key to always perform a cut operation, so you can undo the deletion using the paste function.
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4.6 Launch link in clipboard

You can launch a Bookmark stored as text in clipboard by using the Launch Bookmark in clipboard
function. Accessible thru the Tray Icon and Drop Basket shortcut menu. You can assign a global hotkey
to this command (Settings | Hotkeys) or set it as a Tray Icon / Drop Basket function (Settings | Tray
Icon and Settings | Drop Basket).
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4.7 Open new browser window

You can easily open a new browser window using a menu item in the Tray Icon and Drop Basket shortcut
menu. You can assign a global hotkey to this command (Settings | Hotkeys) or set it as a Tray Icon /
Drop Basket function (Settings | Tray Icon and Settings | Drop Basket).

Linkman will open a new session of your preferred browser (configurable in Settings | Launch
Bookmarks).
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4.8 Print

Set the printer driver 

Run the File | Print setup key combination. The Print setup dialog will appear. Select the Printer that you
want Linkman to use along with other options. Click Ok.

Print a list of Links

Run the File | Print command or press the CTRL + P key combination. The Print dialog will pop up. You
will be able to see the print preview of the list as it would appear when printed on paper. You can move
to any page by changing the page number from the Preview Page edit box. You can also use the Zoom
feature for a  closer inspection of the preview pages.

Press the ALT + S key combination or click the Settings button. Linkman print settings dialog will show.
Type in the headline. This text will appear on each sheet of paper as a header. Select all the attributes of
the Bookmarks that you would like to be printed. Click the Set printer font button. A font dialog will pop
up. Select the font in which you want the text to appear and click Ok. Click Ok again to close the Settings
dialog. Linkman will take a few seconds to process the print options.

Click the Print button. The links will be sent to your selected printer and the Print dialog will close.
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4.9 Set status

In the Properties dialog you can set several Bookmark properties like Ignore while checking for
duplicates or Bookmark validation queue flag. It would be a pain to set the same option for several
Bookmarks manually - here comes the Set Status feature into play. Simply mark the Bookmarks you
want to change (by holding down the SHIFT key and clicking on the Bookmarks), launch the Set Status
command from the shortcut menu and turn any options you want ON or OFF. All selected Bookmarks will
be processed in one step!

Options explained:

Ignore while checking for duplicates

Set this flag and the Bookmark will be ignored while the duplicate search

Ignore page changes

Set this flag and the Bookmark page change status will be ignored while Bookmark validation, this is
useful for web pages that change on a daily basis

Bookmark validation queue flag

Set this flag and the Bookmark will be added to Bookmark validation queue - the icon of the Bookmark
will change to a symbol that indicates that the Bookmark will be processed when Bookmark validation
starts

Page has changed since last launch

Linkman underlines the links with changed web pages after Bookmark validation. You can change the
underline status of links here.

Tip

You can select also folders for this function - all Bookmarks inside the folders will be processed!
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4.10 Show duplicates

1. Let Linkman automatically handle duplicates.

Select the Folder from which you want the duplicates to be removed.

Click the Delete Duplicates  button or run the Tools | Delete Duplicates command.

A dialog box will appear with the following options

Method

Delete 

Deletes the Duplicates found from the Tree

Move to Duplicates Folder

Moves the duplicates found to a Folder. The Duplicates Folder will be created in the root of the Tree with
the name Duplicates on <Date> <Time>.

Fuzzy

If checked Linkman will find also duplicates which differ slightly (e.g. have a different subdomain).

Options

Show every duplicate first

If this option is selected you will be required to choose what you want to do with each duplicate found.
You have the option to delete/move the first/second occurrence or skip the duplicate checking for this
Bookmark or abort the Delete Duplicates run.

Delete / Move occurrence

Deletes the first or second occurrence of the Bookmark without asking.

2. Let Linkman show all duplicates.

Launch Tools | Show all duplicates.
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Linkman can also display duplicates which have slightly variable paths (like different subdomains). Select Duplicates (fuzzy) from
the combo box for this. 



How to...

139Linkman

4.11 Sort items

Search results:

To sort for example by path, click once on the path column header. Click a second time to reverse the
sort order. Click a third time to disable sorting by that column. An arrow in the column header will
indicate the column that is the current sort method.

Treeview display:

If you do not want to sort the whole Tree select all Bookmarks and Folders you want to be sorted by
using the CTRL + left mouse button. 

Run the Edit | Sort command or press the CTRL + L key combination to bring up the Sort dialog. You can
also use the button with the A-Z symbol.

Select your sorting options. If you prefer having your Folders appearing first and then the individual
Bookmarks, you would need to select Folders first. You would also have to specify how you want your
items to be sorted. Most people prefer sorting their entries Alphabetically and according to Rating. In that
case your first sort order would have to be Name and the second to be Rating.

Once your sorting preferences have been selected, click the Sort button.  This will start the sorting
process.

If you want Linkman to sort always (and not only on request) turn on Autosort.

How to add a secondary sorting method to search results?

First go to Edit | Search and select the primary sorting criteria (e.g. Name). Then click header of the
search column you want
sorted (e.g. launch date) to select a secondary sorting criteria.
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4.12 Use the Link Collector

You can find the Link Collector in the Tools menu.

Note: you must use wildcards in the Link Collector. If you search for ware the Link collector will search
for the phrase. This means hardware will not be found. To search for all meanings of ware use *ware*
instead.

Usage examples:

Rating Hunter 

If you require to send someone a collection of your favorite links which are rated 5, you wouldn't have to
hunt through the entire Tree to find the links yourself. You would instead use the Link collector. Here's
how.

Select the panel in which you want to search for Bookmarks with 5 rating. Run the Tools | Link Collector
command. The Link collector dialog will pop up. Set the following parameters:

Bookmarks: checked

Name:*
Path:*
Comment:*
Rating between: 5 & 5

Options: Copy all matches to new folder

Click the Collect button. All Bookmarks with rating 5 will be copied and stored in a Folder called Co lle cted
Links.

Text Search

If you need to send someone a collection of German sites which are related to Tips then you would use
the Link Collector in the following way.

Select the panel in which you want to search for German Bookmarks with Tips. Run the Tools | Link
Collector command. The Link Collector dialog will pop up. Set the following parameters:

Name:*
Path:*.de
Comment:*Tips*
Rating between: 0 & 5

Options: Copy all matches to new folder

Click the Collect button. All Bookmarks with .de domain names and comments containing the word T ips
will be copied and stored in a folder called Co lle cted Links.

Delete empty folders 

Link Collector can also be used for maintenance of your Treeview. Let's say that you want to remove all
Folders which are empty. You would use the Link Collector to clear out the empty Folders in the following
way.

Run the Tools | Link Collector command. The Link Collector dialog will pop up. Set the following
parameters:
 
Bookmarks: unchecked
Folders: unchecked
Empty Folders: checked
Name: *
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Path: *
Comment: *
Rating between: 0 & 5

Options: Move all matches to new Folder

Click the Collect button. All empty Folders will now be moved to the Co lle cted Links Folder. You can
safely delete this Folder.

Get all Bookmarks launched within a date range

Linkman should be configured to store launch dates (Settings | Data).

Run the Tools | Link Collector command. The Link Collector dialog will pop up. Set the following
parameters:
 
Bookmarks: checked
Folders: unchecked
Empty Folders: unchecked
Name: *
Path: *
Comment: *
Rating between: 0 & 5

between: checked
ComboBox: Last launch date
Select the desired date interval in the date edit boxes

Options: Copy all matches to new folder

Click the Collect button. All Bookmarks that have been launched in the selected date range will be copied
and stored in a folder called Co lle cted Links.
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4.13 Create a diary

You can find the Diary function in the Tools menu. Diary is available only in Linkman Pro.

In the upper area of the window the timeframe of the diary can be set.

For every year, month, week and day of the diary you can choose between a folder and a bookmark.

The caption of each item and the date format can be chosen to your liking.

Allowed caption tags

Diary caption
First day of the diary: %fromdate% 
Last day of the diary: %todate%

Diary item (month, week etc)
Current period of the diary: %date%

Allowed %date% format tokens

d Displays the day as a number without a leading zero (1-31)
dd Displays the day as a number with a leading zero (01-31)
ddd Displays the day as an abbreviation (Sun-Sat)
dddd Displays the day as a full name (Sunday-Saturday) 
w Week no according to ISO
ww Week no according to ISO forced two digits
m Displays the month as a number without a leading zero (1-12)
mm Displays the month as a number with a leading zero (01-12)
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mmm Displays the month as an abbreviation (Jan-Dec) 
mmmm Displays the month as a full name (January-December)
yy Displays the year as a two-digit number (00-99)
yyyy Displays the year as a four-digit number (0000-9999)
e Number of the Day in the ISO-week denoted by w (ISO-Notation 1=Monday...)
f Number of the Day in the year denoted by y
fff Number of the Day in the year denoted by y forced three digits 

Examples for the diary day 24 December 2014

type caption %date% format generated output
day %date% dd, dddd 24, Wednesday
day day: %date% ddd day: Wed
week week #%date% ww week #52
month %date% mm/yyyy 12/2014
year %date%th year yy 14th year

Standard diary output
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